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chapter 1

GETTING STARTED

Welcome
Congratulations on purchasing a Compaq iPAQ H3000 Windows Powered Pocket PC. 
Due to the size and capabilities of your iPAQ H3000 Pocket PC, you can keep your most 
important business and personal information up-to-date and close at hand. Microsoft 
ActiveSync increases the power of your iPAQ H3000 Pocket PC by allowing you to 
synchronize the information on your desktop or laptop computer with your Pocket PC. 
Picture yourself in the following situations:

• While walking with a colleague, your cell phone rings and your manager asks if the 
two of you are free this afternoon for an emergency meeting. While your colleague 
fumbles through his paper organizer, you press a button on your iPAQ H3000 and 
instantly see a list of the day’s appointments and meetings. You are quickly able to tell 
your manager your available times. For more information on scheduling appointments 
and meetings, see Chapter 4 (Microsoft Pocket Outlook).

• You’re meeting your friends tonight for dinner and a movie. You download the latest 
movie information from the Internet onto your computer then synchronize it with your 
iPAQ H3000. At dinner, you pull out your iPAQ H3000 and review your movie 
options with your friends. For more information on downloading Web pages to your 
iPAQ H3000, see Chapter 6 (Pocket Internet Explorer).

• A calendar reminder alerts you that it’s time to catch the bus to work. You grab your 
iPAQ H3000 and catch the bus just in time. Because ActiveSync keeps the information 
on your iPAQ H3000 up-to-date, you leisurely review your task list, make notes about 
the new books and CDs you want to buy, and read and respond to e-mail messages. 
When you get back to the office, ActiveSync transfers any task changes you made, 
your notes, and your e-mail message responses to your computer. For more informa-
tion on ActiveSync, see Chapter 3 (Microsoft ActiveSync).
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Where to Find Information
This reference guide describes your iPAQ H3000 Pocket PC hardware, provides an 
overview of the programs on your iPAQ H3000, and explains how to connect your iPAQ 
H3000 to a computer, a network, or the Internet. For instructions on setting up your iPAQ 
H3000, see the Getting Started card. For instructions on installing ActiveSync, see the 
booklet accompanying the ActiveSync CD. The following table is a guide to additional 
information to help you use your iPAQ H3000:

For information on: See this source:

Programs on your iPAQ 
H3000

This reference guide and iPAQ H3000 Help. To 
view Help, tap  then Help.

Additional programs that 
can be installed on your 
iPAQ H3000

The Extras folder, located on the ActiveSync 
CD. -or-
The Virtual Tour, located on the Compaq 
Software and Reference Guide CD.

Connecting to and 
synchronizing with a 
computer

The ActiveSync booklet or online ActiveSync 
Help on your computer. To view online Help, 
open Microsoft ActiveSync on your computer, 
then select Help, Microsoft ActiveSync Help.

Last-minute updates and 
detailed technical 
information

The Read Me files, located in the Microsoft 
ActiveSync folder on the computer and on the 
ActiveSync CD.

Up-to-date information 
on Windows-powered 
devices including tips

Microsoft Windows Powered Home Page 
www.microsoft.com/pocketpc/

The latest information 
and offers for your iPAQ 

Compaq Handheld Home Page 
www.compaq.com/products/handhelds

Information on iPAQ 
accessories and ordering

Accessories Information

Tips and troubleshooting 
information

Online ActiveSync Help on your computer. To 
view the online Help, open Microsoft Active-
Sync on your computer, then select Help, 
Microsoft ActiveSync Help. -or-
Appendix A (Tips and Troubleshooting), in this 
reference guide. -or-
Compaq iPAQ Support Home Page 
www.compaq.com/support/handhelds

Technical support and 
your warranty

The How Do I Get Service and Support for My 
Compaq iPAQ Pocket PC? card.

http://www.microsoft.com/pocketpc
http://www.compaq.com/products/handhelds
http://www.compaq.com/support/handhelds
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Symbols and Conventions
Some or all of the following format conventions may be used in this guide to 
distinguish elements of text: 

• Names of menus, commands and icons are shown in bold type as they appear on the 
display, for example, Settings, Power.       

NOTE: Text set off in this manner presents commentary, sidelights, or interesting points of infor-
mation.

Customer Registration 
You can receive the latest information on your iPAQ H3000 Pocket PC, as well as special 
offers on iPAQ H3000 accessories and software, by registering with Compaq by 
completing and mailing the Register Now* card included in the shipping box or the online 
registration.

* Not available in all regions.

Text set off in this manner indicates that failure to follow directions could result in 
bodily harm or loss of life.

Text set off in this manner indicates that failure to follow directions could result in 
damage to equipment or loss of information.

!
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How to Transfer Palm-size PC Data
If you are currently using a Windows CE-based Palm-size PC and want to transfer your 
data to your iPAQ H3000 Pocket PC, follow this upgrade procedure:

1. Install Microsoft ActiveSync 3.1 on your computer. For information on installing 
ActiveSync, see the booklet accompanying the ActiveSync CD.

2. Synchronize your Palm-size PC with your computer so that the information on your 
computer is current.

NOTE: If you have files on your Palm-size PC that you want to transfer, such as Note Taker 
notes and recordings, turn file conversion off in ActiveSync options so that the files 
stay in device format, and use the ActiveSync Explorer to copy the files to your 
computer. For specific instructions, see ActiveSync Help on the computer.

3. Synchronize your iPAQ H3000 with your computer. This will update your device 
using the current data on your computer (step 2).

4. Reinstall programs. Check whether new versions are available.

NOTE: Some older Palm-size PC programs may not work on your iPAQ H3000 Pocket PC.

NOTE: Copy the files you transferred to your computer to your iPAQ H3000 using the Active-
Sync Explorer. Turn file conversion on again in ActiveSync.

5. Enter your settings and connection information on the iPAQ H3000.

If you have offline folders in Inbox on your Palm-size PC that contain e-mail messages 
you want to transfer to your iPAQ H3000, follow this procedure:

1. Connect your Palm-size PC to your computer then click Windows CE Inbox 
Transfer on the Microsoft Outlook Tools menu.

2. Select Copy or move selected messages to your computer, then click Browse.

3. Select the offline folder that contains the messages you want to transfer to your 
computer, then click OK.

4. Click the Transfer button and select the folder you want to transfer the messages to or 
click New Folder to create a new folder. Click OK to transfer the messages. Now you 
must transfer the messages from your computer to your iPAQ H3000.

5. Tap Tools then New Folder and create a folder for the messages you are going to 
transfer in Inbox on your iPAQ H3000.

6. Select the messages you want to transfer in Outlook on your computer.

7. Connect your iPAQ H3000 to your computer, then click Windows CE Inbox 
Transfer on the Outlook Tools menu.

8. Select Copy selected messages to your mobile device, then click Browse.

9. Select the offline folder on your iPAQ H3000 that you want to transfer the messages 
to, then click OK.

10. Click the Transfer button. The selected messages are moved to your iPAQ H3000.
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chapter 2

BASIC SKILLS
Learning to use your iPAQ H3000 Pocket PC is easy. This chapter describes the basic con-
cepts of using and customizing your iPAQ H3000 Pocket PC.

Front Panel Components

Item Component Function

1 Stylus Allows you to tap or write on the screen. Push the 
stylus release button (w) to release it from the 
compartment.

2 Power Button Powers the iPAQ H3000. Press and release the 
button to turn on or off your iPAQ H3000. Press 
and hold the button for one second to toggle on or 
off the backlight.
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3 Alarm/Charge 
Light

Serves as both a battery charge indicator and a 
visual alarm indicator. 
• Flashing green: Notification alarm signal.
• Flashing amber: Battery is charging.
• Solid amber: Battery is fully charged.

4 Light Sensor Detects the ambient light level so that the back-
light level adjusts to suit the environment (only 
available on iPAQ H3600 Series Pocket PCs).

5 Speaker Sounds alarms and plays back sound recordings.

6 iPAQ Navigator/
Action Button

Allows you to scroll through a list (similar to 
pressing the arrow keys on a keyboard). In the list 
view of a program, you can use your iPAQ Navi-
gator to scroll to the item you want to view. Can 
also be used as game buttons within a game appli-
cation. The center of the button can be used as an 
Action button to open a selected item.

7 Application 
Buttons 

Allow quick access to four applications. By 
default, the applications are Calendar, Contacts, 
QMenu, and QStart. You can change the functions 
of the application buttons to open different appli-
cations. For more information, see “Adjusting 
Settings” later in this chapter.

8 Record Button Activates the record function in Notes. For more 
information, see “Notes” in Chapter 4. You can 
change the function of the Record button so that it 
opens a different application. For more informa-
tion, see “Adjusting Settings” later in this chapter. 

9 Microphone Allows you to record voice messages.

10 Headphone Jack Lets you connect standard headphones.

11 Infrared Port Enables you to exchange data with other Win-
dows-powered devices. The infrared port can 
transmit at speeds up to 115.2Kb per second. For 
information, see Chapter 7 (Getting Conected). 

12 Stylus Release 
Button 

Lets you eject the stylus from its compartment.

Item Component Function

! To reduce the risk of personal injury, turn 
down the volume control before putting on 
headphones.
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Bottom Edge Components

Item Component Function

1 Communications 
Port 

Connects your iPAQ H3000 to the cradle or auto-
sync cable.

2 Reset Button Lets you reset your iPAQ H3000. For more infor-
mation, see “Reset the iPAQ H3000 and Clear 
Memory” in Appendix A.

3 On/Off Switch Allows you to clear all data, and reset your system 
if you have forgotten your password. Clearing 
memory deletes all data and restores your iPAQ 
H3000 to its default settings. For more informa-
tion, see “Reset the iPAQ H3000 and Clear Mem-
ory” in Appendix A.

4 DC Jack Allows you to connect to external power with the 
supplied AC adapter. 

5 iPAQ Expansion 
Pack Connector 

Connects to the connector of an (optional) iPAQ 
Expansion Pack.   
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Cradle and AC Adapter 
Your iPAQ H3000 comes with either a cradle or auto-sync cable, and an AC adapter. This 
allows you to recharge your iPAQ H3000, as well as synchronize the information between 
your iPAQ H3000 and a computer using ActiveSync. For more information on synchroni-
zation, see ActiveSync Help on your computer.

NOTE: The cradle or auto-sync cable must be plugged into an appropriate port on the back of 
your computer. Example, you must plug the serial cradle into a serial port and a USB cra-
dle into a USB port.
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Recharging the Battery
Your iPAQ H3000 contains a rechargeable Lithium Polymer battery that is recharged each 
time you place your iPAQ H3000 in the cradle and connect the cradle to an external power 
source with the AC adapter. You never need to replace the battery. Just place your iPAQ 
H3000 in the cradle for three to four hours for an initial charge before you use it the first 
time. Next, place it in the cradle for a short time each day to recharge the battery to its full 
capacity. 

NOTE: You can also use the AC adapter to connect your iPAQ H3000 directly to the external 
power source. 

If the battery gets very low, your iPAQ H3000 displays a warning message. If this occurs, 
save any unsaved data you are working on, perform a synchronization with your com-
puter, then turn off your iPAQ H3000. Don’t try to restart your iPAQ H3000 until you have 
connected to external power. The battery acts like a rechargeable backup battery by pro-
tecting your data if your iPAQ H3000 shuts down. If your iPAQ H3000 does shut down, 
you still have about 24 hours to recharge the battery before you lose the data on your 
Pocket PC.



2-6 Basic Skills

Compaq iPAQ Expansion Pack System 
Your iPAQ features the iPAQ Expansion Pack System, which allows you to personalize 
the appearance of your iPAQ H3000 or add extra functionality. iPAQ Style Packs offer a 
range of styles to customize your iPAQ, while Expansion Packs, such as the Compact-
Flash Card, or PC Card Expansion Pack, let you add extra features. 

Compaq iPAQ Expansion and Style Packs are designed to easily slide on and off your 
Pocket PC without having to power off your Pocket PC.    

NOTE: For information on ordering Compaq iPAQ Expansion Packs, see the Accessories Informa-
tion card included in the shipping box, or visit the Compaq iPAQ H3000 home page at 
www.compaq.com/products/handhelds/

To add a Compaq iPAQ Expansion Pack:
1. Slide the iPAQ H3000 into the Expansion Pack until it clicks into place. The Pocket 

PC will alert you when the Expansion Pack is ready to be used.

NOTE: You can disable the sound made when you insert the iPAQ 3000 into the Expansion Pack. 
Press the QMenu button, tap Expansion Pack, then select Disable Insertion Sound.

To view the Expansion Pack properties:

Press the QMenu button, then tap Expansion Pack. If the Expansion Pack is installed 
properly, the name of the Expansion Pack will appear in the Expansion Pack Properties 
screen. 

http://www.compaq.com/products/handhelds
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To remove a Compaq iPAQ Expansion Pack: 

Slide the Expansion Pack down and off your iPAQ H3000. 

 

Compaq iPAQ CF Card Expansion Pack
The optional Compaq iPAQ CF Card Expansion Pack supports Type I and Type II Com-
pactFlash cards. The CompactFlash slot allows you to install storage cards for backup and 
storage of data and applications. It also allows you to install communication devices such 
as a LAN adapter or a fax/modem. 

To insert a CompactFlash card: 
1. Remove the CompactFlash slot cover. 

NOTE: The CompactFlash slot cover can and should be replaced only when the slot is empty. 
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2. Push the card, connector-side first into the slot until it stops. 

NOTE: Do not force the card into the slot. If the card does not seem to fit, verify that it is 
facing the correct direction and that you are not inserting the card at an angle.

To remove a CompactFlash card: 
1. Close all applications on your iPAQ H3000 that have open files on the CompactFlash 

card.

2. Lever the CompactFlash card out of the slot using a fingernail. 

Guidelines for Using CompactFlash Cards
• Your iPAQ H3000 automatically recognizes a wide range of CompactFlash cards 

approved for use with ActiveSync. If you are ever instructed to install card-specific 
iPAQ H3000 drivers provided by a CompactFlash card manufacturer, be sure to install 
only device drivers specifically designed for the operating system on your iPAQ 
H3000. If you are unclear about installation instructions, call your CompactFlash card 
manufacturer for more information.

• Some CompactFlash cards consume large amounts of power. To avoid battery drain-
age when using a CompactFlash card, connect your iPAQ H3000 to AC power wher-
ever possible.

• If the battery is very low, you should not attempt to save data to a CompactFlash card. 
This may result in the loss of data. First connect to AC power.

• Do not turn off your iPAQ H3000 or remove the CompactFlash card when you are in 
the middle of performing an operation, such as saving data to your CompactFlash 
card. 

• Keep your CompactFlash card in a protective case when not in use to protect it from 
dirt and moisture.
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The Stylus
Your iPAQ H3000 has a stylus for selecting items and entering information. To use the 
stylus, press and hold the stylus release button while pulling the stylus upward out of its 
compartment. To replace the stylus, just insert it back into the compartment, then push it 
until it clicks into place.

The following actions are available with the stylus: 

• Tap. Touch the screen once with the stylus to open items and select options.
• Drag. Hold the stylus on the screen and drag it across the screen to select text and 

images. Drag within a list to select multiple items.
• Tap-and-hold. Tap and hold the stylus on an item to see a list of actions available for 

that item. Tap the action you want to perform on the pop-up menu that appears.

NOTE: The stylus tip can also be used to press the reset button or set the On/Off switch. 



2-10 Basic Skills

Today Screen
When you turn on your iPAQ H3000 for the first time each day (or after 4 hours of inactiv-
ity), you’ll see the Today screen. You can also display it by tapping  then Today. On 
the Today screen, you can see at a glance important information for the day.

You may see the following status icons on the command bar in the Today screen. 

Status Icon Description

Turns all sounds on and off 

Main battery is charging 

Main battery is low

Main battery is very low 

External (AC) power source is connected 

Dial-up connection is active

Direct connection is active
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Programs
You can switch from one program to another by selecting it from the  menu. (You can 
customize which programs you see on this menu. For information, see “Adjusting Set-
tings”, later in this chapter.) You can also use QStart to switch between programs. See 
“QStart” later in this chapter. 

NOTE: Some programs have abbreviated labels for check boxes and drop-down menus. To see 
the full spelling of an abbreviated label, tap and hold the stylus on the label. Drag the sty-
lus off the label so that the command is not carried out.

NOTE: You can also switch to some programs by pressing an application button. Your iPAQ 
H3000 has four application buttons located on the front of your iPAQ H3000, and the 
Record button located on the side. The following icons on the buttons on the front of the 
iPAQ identify the programs they switch to: 

Item Icon Program

1 Calendar

2 Contacts

3 QMenu

4 QStart
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The following table contains a partial list of programs that are on your iPAQ H3000. Look 
in the Compaq CD and the Extras folder on the ActiveSync CD for additional programs 
that you can install onto your iPAQ H3000.

Icon Program Description

Calendar Keep track of your appointments and 
create meeting requests.

Contacts Keep track of your friends and 
colleagues.

Inbox Send and receive e-mail messages.

Infrared 
Receive

Receive information from another 
Windows-powered device. 

Internet 
Explorer

View Web pages downloaded from 
your computer or connect to an ISP 
and browse the Web.

Microsoft 
Money

Enter and view transactions and check 
on your account balances. (Available 
for English operating systems only.)

Microsoft 
Reader

Read or listen to (using Audible) 
electronic books on your iPAQ.

Notes Create handwritten or typed notes, 
drawings, and recordings.

Picture 
Viewer

View bitmap or JPEG images on your 
iPAQ. 

Pocket 
Excel

Create new workbooks or view and 
edit Excel workbooks created on your 
computer.

Pocket 
Word

Create new documents or view and 
edit Word documents created on your 
computer.

QMenu Activates the QMenu which provides 
easy-open programs and quick access 
to activities and the QUtilities.

QStart Allows you to quickly access 
programs.

Tasks Keep track of your tasks.
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Navigation Bar and Command Bar
The navigation bar is located at the top of the screen and displays the title of the active 
program and current time. It also allows you to switch to programs and close screens. 

Use the command bar at the bottom of the screen to perform tasks in programs. The com-
mand bar includes menu names, buttons, and the input panel button. To create a new item 
in the current program, tap New. To see the name of a button on screen, tap and hold the 
stylus on the button. Drag the stylus off the button so that the command is not carried out.

Tap to close the screen.

Tap to select a program.

Tap to select a program.

Tap to see additional programs.

Tap to customize the device.

New button

Menu names
Buttons

Input panel button
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Pop-up Menus
With pop-up menus, you can quickly choose an action for an item. For example, you can 
use the pop-up menu in the contact list to quickly delete a contact, make a copy of a con-
tact, or send an e-mail message to a contact. The actions in the pop-up menus vary from 
program to program. To access a pop-up menu, tap and hold the stylus on the item name 
that you want to perform the action on. When the menu appears, lift the stylus, and tap the 
action you want to perform. Or tap anywhere outside the menu to close the menu without 
performing an action.

Notifications
Your iPAQ H3000 reminds you in a variety of ways when you have something to do. For 
example, if you’ve set up an appointment in Calendar, a task with a due date in Tasks, or 
an alarm in Clock, you’ll be notified in any of the following ways:

• A message box appears on the screen.
• A sound, which you can specify, plays.
• The green alarm light flashes on your iPAQ H3000. 

To choose reminder types and sounds for your iPAQ H3000, tap  then Settings. In the 
Personal tab, tap Sounds & Reminders. The options you choose here apply throughout 
your iPAQ H3000.

Tap and hold to display 
the pop-up menu.

Lift the stylus and tap 
the action you want.

Tap outside the menu to 
close it without performing 
an action.
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Enter Information on Your iPAQ
You have several options for entering new information:

• Enter typed text in the input panel by using the soft keyboard or Character Recognizer.
• Write or draw pictures directly on the screen.
• Speak into your iPAQ H3000 microphone to record a message.
• Synchronize or copy information from your computer to your iPAQ H3000 using 

ActiveSync. For more information on ActiveSync, see the booklet accompanying the 
ActiveSync CD or ActiveSync Help on your computer.

Typing Using the Input Panel 
Use the input panel to enter information in any program on your iPAQ H3000. You can 
either type using the soft keyboard or write using Character Recognizer. In either case, the 
characters appear as typed text on the screen. 

Tap the Input Panel button to show or hide the input panel, then tap the arrow next to the 
Input Panel button to see your choices.

Select an input method.

Tap to see your choices.

Input panel button
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When you use the input panel, your iPAQ H3000 anticipates the word you are typing or 
writing and displays it above the input panel. When you tap the displayed word, it is 
inserted into your text at the insertion point. The more you use your iPAQ H3000, the 
more words it learns to anticipate.

NOTE: To change word suggestion options, such as the number of words suggested at one time, 
tap , Settings, Personal tab, Input, then the Word Completion tab.

To type with the soft keyboard:
1. Tap the arrow next to the Input Panel button then Keyboard.

2. Tap the keys with your stylus on the soft keyboard that displays. 

To use Character Recognizer:
1. Tap the arrow next to the Input Panel button then Character Recognizer.

2. Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the screen. For spe-
cific instructions on using Character Recognizer, see Appendix B.

To select typed text:

If you want to edit or format typed text, you must select it first by dragging the stylus 
across the text you want to select.

You can cut, copy, and paste text by tapping and holding the selected words then tapping 
an editing command on the pop-up menu, or by tapping the command on the Edit menu.

Tap here if this is 
the right word.
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Writing on the Screen
In any program that accepts writing, such as the Notes program and the Notes tab in Cal-
endar, Contacts, and Tasks, you can use your stylus to write directly on the screen. Write 
the way you do on paper. You can edit and format what you’ve written and convert the 
information to text at a later time.

To write on the screen:

Tap the Pen button to switch to writing mode. This action displays lines on the screen to 
help you write.

NOTE: Some programs that accept writing may not have the Pen button. See the documentation 
for that program to find out how to switch to writing mode.

To select writing:

If you want to edit or format writing, you must select it first.

1. Tap and hold the stylus next to the text you want to select until the insertion point 
appears.

2. Drag the stylus across the text you want to select without lifting the stylus. 

If you accidentally write on the screen, tap Tools then Undo and try again. You can also 
select text by tapping the Pen button to deselect it then dragging the stylus across the 
screen.

Tap the Pen button and use 
your stylus like a pen.
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You can cut, copy, and paste written text in the same way you work with typed text: tap 
and hold the selected words then tap an editing command on the pop-up menu, or tap the 
command on the Edit menu.

To convert writing to text:
• Tap Tools then Recognize.

If you want to convert only certain words, select them before tapping Recognize on the 
Tools menu (or tap and hold the selected words then tap Recognize on the pop-up menu). 
If a word is not recognized, it is left as writing.

Select the text you want to 
convert and tap Recognize 
on the pop-up menu.

The writing is turned into text.



Basic Skills 2-19

If the conversion is incorrect, you can select different words from a list of alternates or 
return to the original writing. To do so, tap and hold the incorrect word (tap one word at a 
time). On the pop-up menu, tap Alternates. A menu with a list of alternate words appears. 
Tap the word you want to use, or tap the writing at the top of the menu to return to the 
original writing.

Tips for getting good recognition:

• Write neatly.
• Write on the lines and draw descenders below the line. Write the cross of the “t” and 

apostrophes below the top line so that they are not confused with the word above. 
Write periods and commas above the line.

• For better recognition, try increasing the zoom level to 300% using the Tools menu.
• Write the letters of a word closely and leave big gaps between words so that your iPAQ 

H3000 can easily tell where words begin and end.
• Hyphenated words, foreign words that use special characters such as accents, and 

some punctuation cannot be converted.
• If you add writing to a word to change it (such as changing a “3” to an “8”) after you 

attempt to recognize the word, the writing you add will not be included if you attempt 
to recognize the writing again. 

Tap to return to your 
original writing.

Or, tap the word you 
want to use.
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Drawing on the Screen
You can draw on the screen in the same way that you write on the screen. The difference 
between writing and drawing on the screen is how you select items and how they can be 
edited. For example, selected drawings can be resized, while writing cannot.

To create a drawing:
• Cross three ruled lines on your first stroke. A drawing box appears. Subsequent 

strokes in or touching the drawing box become part of the drawing. Drawings that do 
not cross three ruled lines will be treated as writing.

NOTE: You may want to change the zoom level so that you can more easily work on or view your 
drawing. Tap Tools then a zoom level.

To select a drawing:

If you want to edit or format a drawing, you must select it first. Tap and hold the stylus on 
the drawing until the selection handle appears. To select multiple drawings, deselect the 
Pen button then drag to select the drawings you want.

You can cut, copy, and paste selected drawings by tapping and holding the selected draw-
ing then tapping an editing command on the pop-up menu, or by tapping the command on 
the Edit menu. To resize a drawing, make sure the Pen button is not selected and drag a 
selection handle.

The drawing box indicates the 
boundaries of the drawing.

Pen button
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Recording a Message
In any program where you can write or draw on the screen, you can also quickly capture 
thoughts, reminders, and phone numbers by recording a message. In Calendar, Tasks, and 
Contacts, you can include a recording in the Notes tab. In the Notes program, you can 
either create a stand-alone recording or include a recording in a written note. If you want 
to include the recording in a note, open the note first.

To create a recording: 
1. Hold your iPAQ H3000 so that the microphone is near your mouth or other source of 

sound.

2. Press and hold the Record button on the side of your iPAQ H3000.

3. Make your recording while holding down the Record button. 

4. Release the Record button to stop recording. Two beeps will sound. The new recording 
appears in the note list or as an embedded icon.

NOTE: You can also make a recording by tapping the Record button on the Recording toolbar.

To play a recording, tap it in the list or tap its icon in the note.

Indicates an 
embedded 
recording.

Tap to begin 
recording.

Tap to show or hide the Recording toolbar.
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Find Information
The Find feature on your iPAQ H3000 helps you quickly locate information. On the  
menu, tap Find. Enter the text you want to find, select a data type, then tap Go to start the 
search.

NOTE: To quickly find information that is taking up storage space on your iPAQ H3000, select 
Larger than 64 KB in Type.

Customize Your iPAQ H3000
You can customize your iPAQ H3000 by adjusting iPAQ H3000 settings and installing 
additional software.

Adjusting Settings
You can adjust iPAQ H3000 settings to suit the way you work. To see available options, 
tap , Settings, then the Personal, System, or Connections tab located at the bottom of 
the screen. You can also view settings by pressing the QMenu button, then tapping Set-
tings.

You might want to adjust the following:

Item Description

Align Screen Adjust the touch screen if it is not responding accurately.

Asset Viewer Access detailed information about your iPAQ H3000 as well as 
your owner information. 

Backlight Set the time before the backlight turns off when the iPAQ is 
idle.

Auto Run Allow specialized programs stored on a CompactFlash card to 
begin running automatically as soon as the card is inserted.

Buttons Associate program buttons with specific programs and adjust 
the up/down control of your iPAQ Navigator. 

Clock Change the time or set alarms.

Input Customize the input method and set word completion settings.

Memory Adjust the allocation of storage and program memory.

Menus Customize what appears on the  menu and enable a pop-up 
menu from the New button.
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Setting a Password
Password security is provided to help protect against unauthorized use of your iPAQ 
H3000. For immediate protection, Compaq recommends setting up the password security 
through the Password utility in the Settings of your iPAQ H3000 as soon as possible. If 
set, your login password must be entered each time you turn on your iPAQ H3000. 

NOTE: Choose a password that's easy to remember. If you forget it, you must perform a full reset 
to use your iPAQ H3000 again. A full reset restarts your iPAQ H3000 and removes all infor-
mation that was stored in memory, such as your data files and your system settings.

To set your login password, follow these steps: 

1. Tap , Settings, then Password.

2.  Enter a new 4-digit PIN. This number is now your password. 

3. Enable the login password by checking the Require password when device is turned 
on box. 

4. Save your new settings by tapping OK.

Your login password is now set. The login password screen appears each time you turn on 
your iPAQ H3000.

Microphone 
AGC

Enable or disable Automatic Gain Control function (automati-
cally adjusts the recording volume).

Owner
Information

Enter your contact information.

Password Limit access to your iPAQ H3000.

Power Maximize battery life.

Regional 
Settings

Customize the appearance of numbers, currency, times and 
dates.

Remove 
Programs

Uninstall a program. 

Sounds and 
Reminders

Customize or turn off sounds.

Today Customize the information displayed on the Today screen.

Item Description
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Adding or Removing Programs
Programs added to your iPAQ H3000 at the factory are stored in ROM (read-only mem-
ory). You cannot remove or modify this software, and you’ll never accidentally lose ROM 
contents. Programs and data files added to your iPAQ H3000 after factory installation are 
stored in RAM (random access memory). You can install any program created for your 
iPAQ H3000, as long as your iPAQ H3000 has enough memory. You can also install a pro-
gram to a CompactFlash card inserted into your iPAQ H3000. The most popular place to 
find software for your iPAQ H3000 is on the World Wide Web.

To add programs

You’ll need to install the appropriate software for your iPAQ H3000 on your computer 
before installing it on your iPAQ H3000.

1. Download the program to your computer (or insert the CD or disk that contains the 
program into your computer). You may see a single *.exe file, a *.zip file, a Setup.exe 
file, or several versions of files for different iPAQ H3000 types and processors. Be 
sure to select the program designed for the Pocket PC and your iPAQ H3000 processor 
type (StrongARM SA-1110).

2. Read any installation instructions, Read Me files, or documentation that comes with 
the program. Many programs provide special installation instructions.

3. Connect your iPAQ H3000 and computer.

4. Double-click the *.exe file.

5. If the file is an installer, the installation wizard will begin. Follow the directions on the 
screen. Once the software has been installed on your computer, the installer will auto-
matically transfer the software to your iPAQ. 
If the file is not an installer, you will see an error message stating that the program is 
valid but it is designed for a different type of computer. You will need to move this file 
to your iPAQ. If you cannot find any installation instructions for the program in the 
Read Me file or documentation, use ActiveSync Explore to copy the program file to 
the Program Files folder on your iPAQ. For more information on copying files using 
ActiveSync, see ActiveSync Help. 

Once installation is complete, tap , Programs, then the program icon to switch to it.

To add a program to the Start menu:

Tap , Settings, Menus, the Start Menu tab, then the check box for the program. If 
you do not see the program listed, you can either use File Explorer on your iPAQ to move 
the program to the Start Menu folder or use ActiveSync on the computer to create a short-
cut to the program and place the shortcut in the Start Menu folder.
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Using File Explorer on your iPAQ:

1. Tap , Programs, File Explorer, and locate the program (tap the folder list, labeled 
My Documents by default, then My Device to see a list of all folders on your iPAQ).

2. Tap and hold the program and tap Cut on the pop-up menu. 

3. Open the Start Menu folder located in the Windows folder, tap and hold a blank area of 
the window, and tap Paste on the pop-up menu. The program will now appear on the 

 menu. For more information on using File Explorer, see “Find Information,” ear-
lier in this chapter.

Using ActiveSync on the computer: 

1. Use the Explorer in ActiveSync to explore your iPAQ files and locate the program.

2. Right-click the program, then click Create Shortcut. 

3. Move the shortcut to the Start Menu folder in the Windows folder. The shortcut now 
appears on the  menu. For more information, see ActiveSync Help.

To remove programs:
1. Tap  then Settings. 

2. Tap Remove Programs on the System tab.

3. Use File Explorer on your iPAQ to locate the program if the program does not appear 
as an installed program.

4. Tap and hold the program. 

5. Tap Delete on the pop-up menu.
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Power 
When you are working with your iPAQ H3000 and using battery power, you can monitor 
the charge held in the battery by using the Power window. To conserve battery power, your 
iPAQ H3000 automatically powers off whenever it is idle for a continuous period of time. 
If you are running on battery power, you can conserve charge if you shorten the idle time 
before your iPAQ H3000 automatically powers off.

To display the Power control panel: 

Tap , Settings, System, then Power. 

NOTE: If the battery is low on charge, the battery icon appears on the command bar on the Today 
screen. Tap the battery icon to display the Power control panel.

NOTE: If the battery gets very low, your iPAQ H3000 displays a warning message. If this occurs, 
save any unsaved data you are working on, perform a synchronization with your com-
puter, then turn off your iPAQ H3000. Don’t try to restart your iPAQ H3000 until you have 
connected to external power. If your iPAQ H3000 shuts down, you still have about 24 
hours to recharge the battery before you lose the data on your iPAQ H3000. 

The Power control panel only shows the battery charge level if you are using the battery. If 
you have connected the AC adapter, the window shows the recharging status.   

To set the power off timer: 
1. Tap , Settings, System, then Power.

2. Use the drop down menus to set the idle intervals before your iPAQ automatically 
powers off.
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Adjusting the Backlight
The backlight on your iPAQ H3000 lets you view text and graphics clearly whether you're 
indoors or outdoors, in a dim study or at a brightly lit worksite.

NOTE: The iPAQ H3600 Series features a built-in light sensor that allows the iPAQ to automati-
cally adjust the backlight brightness according to the ambient lighting level.

You can manually change the backlight setting on your iPAQ H3100 Series Pocket PC by 
pressing the QMenu button and tapping Backlight. Choose the desired setting.

To set the backlight to reverse:

Set the backlight to reverse mode to display dark text on a white background in dimly-lit 
environments and white text on a dark background in brightly-lit areas. Simply press the 
QMenu button, then tap Backlight, Reverse.
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To adjust the backlight time-out:
1. Press the QMenu button, then tap Backlight, Properties. 

2. Use the drop-down menus to set the amount of idle time before the backlight turns off 
when your iPAQ is using battery power and external power.

QStart 
QStart allows you to quickly access programs on your iPAQ Pocket PC. There are two 
ways to access the QStart:

• Press the QStart button. 

• Tap , Programs then QStart.

To open a program, select a category from the pop-up menu at the bottom of the screen, 
then tap the program icon. To customize the appearance of the QStart categories, tap 
Tools. You can create a new category or add or remove applications from an existing cate-
gory. 
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QUtilities and QMenu 
Customizing your iPAQ Pocket PC is both convenient and easy when you use the QMenu 
and the QUtilities. The QMenu and QUtilities let you quickly access several important 
setting controls. The QMenu also lets you switch between, or close, open applications.

The QUtilities are located on the QMenu. There are four ways to access the QMenu:

• Press the QMenu button. 
• Tap the Q icon on the command bar in QStart. 
• Tap the Q icon on the command bar on the Today screen. 

• Tap , Programs then QMenu. 

If you want to remove the Q icon from your command bar, tap Exit on the QMenu. To 
restore the Q icon, tap , then QMenu. 

To change which items appear on the QMenu, press the QMenu button, then tap QUtili-
ties, QMenu. Any items that you select will appear on the QMenu. 

Task Management
The QMenu allows you to close or switch among tasks on your iPAQ H3000. You can 
close the program that is currently active by tapping Close active task. Close all the open 
programs on your iPAQ H3000 by tapping Close all tasks.

NOTE: When you close a task, all unsaved data in that task is lost.

Below these two options is a list of running tasks. To switch among running tasks, tap the 
name of the task you want to go to.
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File Explorer
You can use the File Explorer to find files on your iPAQ and to organize these files into 
folders. Press the QMenu button, then tap File Explorer.

NOTE: You can move files in File Explorer by tapping and holding the item you want to move then 
tapping Cut or Copy and Paste on the pop-up menu.

Self Test
The Self Test utility within QUtilities activates a debugging and system diagnostic tool. 
Use this tool to verify any problems that you may have experienced on your iPAQ. 

1. Press the QMenu button, then tap Close all tasks to close all active programs. 

2. If you have enabled password protection at power-on, disable this by tapping , 
Settings, then Password. Enter your 4-digit PIN, then deselect the Require password 
check box. 
If you have enabled display owner identification at power-on, disable this by tapping 

, Settings, then Owner Information. Deselect the Show information when 
device is turned on check box. 

Select the sort 
order for the list.

Tap the folder 
name to open it.

Tap and hold 
to create a 
new folder.
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3. Press the QMenu button, then tap QUtilities, then Self Test. 

4. Tap the check boxes to select the items you want to test, then tap Next. 

NOTE: The "IR transfer" test item is an internal infrared functionality test. You do not need to 
set up another IR iPAQ to test this item.

5. Tap Start. Your iPAQ will reset (unless you have disabled this option), and the test 
will start automatically. Follow the instructions to complete the test. When Self Test 
finishes running, it displays the result of each test item. 

6. Tap Finish. You can also choose to save the results as a log file. This is stored in My 
Documents on your iPAQ. 

7. Tap OK to exit.

8. Reset your password and owner information settings.

To read the Self Test log file on your computer: 
1. Connect your iPAQ to your computer, then use ActiveSync to copy the file from My 

Documents on your iPAQ, to your computer. 

2. Open the SelfTest.log file in WordPad on your computer. 
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Controlling Volume 
The Volume utility provides an easy way to adjust the volume of your iPAQ H3000. 

1. Press the QMenu button, then tap Volume. 

- or-

Tap , Settings, System, then Sounds & Reminders. 

2. Adjust the volume level on the slider. 

3. Tap OK to save the new setting. 

Contrast
The Contrast utility allows you to adjust the display contrast of your iPAQ for easy view-
ing in any lighting environment. To adjust the display contrast:

1. Press the QMenu button, then tap Contrast, then Set Contrast.

2. Adjust the slider until the contrast is suitable, then tap OK.
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Backup and Restore Data
To avoid losing your data in the event that your iPAQ Pocket PC is lost, stolen, or becomes 
defective, Compaq recommends periodic backups to the computer or a CompactFlash 
card. Depending on your usage, you may want to perform a backup as often as once a day. 
You can back up and restore your iPAQ's data using the following utilities: 

• ActiveSync Backup/Restore. Use this ActiveSync utility to periodically back up your 
iPAQ's data onto your computer’s hard drive. You can manually back up data or set 
this utility to back up automatically each time you connect to your Pocket PC. For 
more information, see ActiveSync Help on your computer.

• Backup. This utility lets you back up and restore your entire Pocket PC memory con-
tents as well as save your Contacts list to a CompactFlash storage card (purchased sep-
arately). You can then carry a CompactFlash card–based copy of your data with you at 
all times for quick retrieval.

Saving Contacts
You can backup or save the contents of your contact list to a CompactFlash card by press-
ing the QMenu button and tapping QUtilities. Tap the Backup tab and tap Save Contacts.

NOTE: Tapping Erase All deletes the contacts backup saved to flash memory. Data is not deleted 
from the Contacts application.

Backing up Data to a CF Card
Each time you use the Backup utility, your data files, databases, preferences, ActiveSync 
system data, and applications are copied to the CompactFlash storage card. The subdirec-
tories on your iPAQ H3000 are also duplicated on the storage card.

NOTE: Backup is designed for use with CompactFlash storage cards that are approved by 
Microsoft as Windows CE compatible. You should use a card at least as big as your iPAQ 
H3000's RAM (Random Access Memory) size, e.g., 16 or 24 MB. For information on 
ordering a CompactFlash storage card, see the Accessories Information included in the 
shipping box. For a list of other Compaq-tested CompactFlash cards, visit the Compaq 
iPAQ H3000 home page at www.compaq.com/products/handhelds.

To perform a backup: 
1. Connect to external power or, tap , Settings, System, then Power to verify that the 

battery has a charge rating of 20% or greater.

2. Install the optional Compaq iPAQ CF Card Expansion Pack and CompactFlash storage 
card on your iPAQ, as described earlier this chapter. 

3. Press the QMenu button, then tap Close all tasks, to close all active programs.

http://www.compaq.com/products/handhelds
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4. Press the QMenu button, then tap QUtilities, Backup, then Backup to CF. The screen 
displays a list of all the items that will be backed up, so it is easy to identify the data 
and size that is saved to the CompactFlash storage card.

5. Tap the Start button to begin the backup process. A status bar reports the data activity 
until the function is complete. 

6. When backup is complete, remove the CompactFlash storage card and keep it close for 
easy retrieval.

To restore a backup onto your iPAQ Pocket PC: 
1. Install the optional Compaq iPAQ CF Card Expansion Pack and CompactFlash storage 

card on your iPAQ.

2. Turn on your iPAQ. 

3. Press the QMenu button, then tap Close all tasks to close all active programs.

4. Press the QMenu button, then tap QUtilities, Backup tab.

5. Tap Restore from CF.

6. Tap the Start button to begin the restore process. A status bar reports the data activity 
until the function is complete.    

7. Press the reset button to restart your iPAQ when the restore process is complete.

Do not remove the CF card or turn off the unit during backup. Data loss can result.

Do not remove the CF card, or turn off the unit during restore. Data loss can result.
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chapter 3

MICROSOFT ACTIVESYNC
Using Microsoft ActiveSync, you can synchronize the information on your computer with 
the information on your iPAQ H3000 Pocket PC. Synchronization compares the data on 
your iPAQ H3000 Pocket PC with your computer and updates both computers with the 
most recent information. For example:

• Keep Pocket Outlook data up-to-date by synchronizing your iPAQ H3000 with your 
choice of Microsoft Outlook, Microsoft Schedule+, or Microsoft Exchange on your 
computer. 

• Synchronize Microsoft Word and Microsoft Excel documents between your iPAQ 
H3000 and computer. Your files are automatically converted to the correct format. 

NOTE: By default, ActiveSync does not automatically synchronize all types of information, for 
example, e-mail messages. Use ActiveSync options to turn synchronization on and off for 
specific information types.

With ActiveSync, you can also:

• Back up and restore your iPAQ H3000 data. 
• Copy (rather than synchronize) files between your iPAQ H3000 and computer. 
• Control when synchronization occurs by selecting a synchronization mode. For exam-

ple, you can synchronize continually while the iPAQ H3000 is in the cradle or only 
when you choose the synchronize command.

• Select which information types are synchronized and control how much data is syn-
chronized. For example, you can choose how many weeks of past appointments you 
want synchronized.

For information on installing ActiveSync, see the booklet accompanying the ActiveSync 
CD. For information on using ActiveSync, see ActiveSync Help on the computer.
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chapter 4 

MICROSOFT POCKET OUTLOOK
Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and Notes. You can 
use these programs individually or together. For example, e-mail addresses stored in Con-
tacts can be used to address e-mail messages in Inbox. 

Using ActiveSync, you can synchronize information in Microsoft Outlook, Microsoft 
Schedule+, or Microsoft Exchange on your computer with your iPAQ H3000. Each time 
you synchronize, ActiveSync compares the changes you made on your iPAQ H3000 and 
computer and updates both with the latest information. For information on using Active-
Sync, see ActiveSync Help on the computer.

You can switch to any of these programs by tapping them on the  menu.
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Calendar: Scheduling Appointments and Meetings
Use Calendar to schedule appointments, including meetings and other events. You can 
check your appointments in one of several views (Agenda, Day, Week, Month, and Year) 
and easily switch views by using the View menu.

NOTE: You can customize the Calendar display, such as changing the first day of the week, by 
tapping Options on the Tools menu. 

Tap to go to today.

Tap to display or edit the 
appointment details.

Tap to create a new appointment.
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To create an appointment:
1. Tap the desired date and time for the appointment if you are in Day or Week view.

2. Tap New.

3. Enter a description and a location using the input panel. Tap first to select the field. 

4. Tap the date and time to change them, if needed.

5. Enter other desired information. You will need to hide the input panel to see all avail-
able fields.

6. Tap the Notes tab to add notes. You can enter text, draw, or create a recording. For 
more information on creating notes, see “Notes: Capturing Thoughts and Ideas”, later 
in this chapter.

7. Tap OK to return to the calendar when finished. 

NOTE: If you select Remind me in an appointment, your iPAQ H3000 will remind you according 
to the options set in , Settings, Personal tab, Sounds & Reminders. 

Tap to return to the calendar (the 
appointment is saved automatically).

Tap to choose from 
predefined text.
Tap to choose from previously 
entered locations.

Tap to select a time.
Tap to select a date.

Notes is a good place for 
maps and directions.
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Using the Summary Screen
When you tap an appointment in Calendar, a summary screen is displayed. Tap the top 
portion of the summary screen to change the appointment.

Tap to edit the 
appointment details.

Tap to enter or 
edit notes.
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Creating Meeting Requests
You can use Calendar to set up meetings with users of Outlook, Pocket Outlook, or Sched-
ule+. The meeting notice will be created automatically and sent either when you synchro-
nize Inbox or when you connect to your e-mail server. Indicate how you want meeting 
requests sent by tapping Tools then Options. If you send and receive e-mail messages 
through ActiveSync, select ActiveSync.

To schedule a meeting:
1. Create an appointment.

2. Tap the Input Panel button to hide the input panel, then tap Attendees in the appoint-
ment details.

3. Select the meeting attendees from the list of e-mail addresses you’ve entered in Con-
tacts. 

The meeting notice is created automatically and placed in the Outbox folder. For more 
information on sending and receiving meeting requests, see Calendar Help and Inbox Help 
on the iPAQ H3000.
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Contacts: Tracking Friends and Colleagues
Contacts maintains a list of your friends and colleagues so that you can easily find the 
information you’re looking for, whether you’re at home or on the road. Using the iPAQ 
H3000 infrared port, you can quickly share Contacts information with other Windows-
powered device users.

NOTE: To change the way information is displayed in the list, tap Tools then Options.

Tap and enter part of a name 
to quickly find it in the list.

Tap to see additional phone num-
bers and e-mail addresses.

Tap to display or edit 
the contact details.

Tap and hold to display a 
pop-up menu of actions.

Tap to create a new contact.

Select the category of contacts you want displayed in the list.
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To create a contact:
1. Tap New.

2. Enter a name and other contact information using the input panel. You will need to 
scroll down to see all available fields.

3. Scroll to and tap Categories and select a category from the list to assign the contact to 
a category. In the contact list, you can display contacts by category.

4. Tap the Notes tab to add notes. You can enter text, draw, or create a recording. For 
more information on creating notes, see “Notes: Capturing Thoughts and Ideas”, later 
in this chapter.

5. Tap OK to return to the contact list when finished.

Tap to return to the contact 
list (the contact is saved 
automatically).

Scroll to see more fields.

Notes is a good place for 
maps and directions.
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Using the Summary Screen
When you tap a contact in the contact list, a summary screen is displayed.

Tap to edit the 
contact details.

Tap to enter or 
edit notes.



Microsoft Pocket Outlook 4-9

Tasks: Keeping a To Do List
Use Tasks to keep track of what you have to do. In the task list, overdue tasks are dis-
played in bold (and in red on the color iPAQ H3000 and 3000).

NOTE: To change the way information is displayed in the list, tap Tools then Options.

Select the sort 
order of the list.

Select the category of tasks you want displayed in the list.

Indicates high priority.

Tap to display or edit 
the task details.

Tap and hold to display a 
pop-up menu of actions.

Tap to create a new task.
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To create a task:
1. Tap New.

2. Enter a description using the input panel.

3. Enter a start date and due date or enter other information by first tapping the field. If 
the input panel is open, you will need to hide it to see all available fields.

4. Tap Categories and select a category from the list to assign the task to a category. In 
the task list, you can display tasks by category.

5. Tap the Notes tab to add notes. You can enter text, draw, or create a recording. For 
more information on creating notes, see “Notes: Capturing Thoughts and Ideas”, later 
in this chapter.

6. Tap OK to return to the task list when finished.

NOTE: To quickly create a task with only a subject, tap Entry Bar on the Tools menu. Then, tap 
Tap here to add a new task and enter your task information.

Tap to choose from 
predefined subjects.

Notes is a good place 
for maps and drawings.

Tap to return to the task list (the task is saved automatically).
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Using the Summary Screen
When you tap a task in the task list, a summary screen is displayed.

Tap to edit the 
task details.

Tap to show and hide 
additional summary 
information.

Tap to enter or 
edit notes.
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Notes: Capturing Thoughts and Ideas
Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with Notes. 
You can create a written note or a recording. You can also include a recording in a note. If 
a note is open when you create the recording, it will be included in the note as an icon. If 
the note list is displayed, it will be created as a stand-alone recording.

Tap to change the 
sort order of the list.

Tap to open a note or 
play a recording.

Tap and hold to display a 
pop-up menu of actions.

Tap to record.

Tap to show or hide the 
Recording toolbar.
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To create a note:
1. Tap New.

2. Create your note by writing, drawing, typing, and recording. For more information 
about using the input panel, writing and drawing on the screen, and creating record-
ings, see Chapter 2 (Basic Skills).

Tap to return to the 
note list (the note is 
saved automatically).

Tap to write on 
the screen.

Tap to add a recording 
to the note.

Tap to show or hide 
the input panel.
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Inbox: Sending and Receiving E-mail Messages
Use Inbox to send and receive e-mail messages in either of these ways:

1. Synchronize e-mail messages with Microsoft Exchange or Outlook on your computer.

2. Send and receive e-mail messages by connecting directly to an e-mail server through 
an Internet service provider (ISP) or a network.

Synchronizing E-mail Messages
E-mail messages can be synchronized as part of the general synchronization process. First, 
enable Inbox synchronization in ActiveSync options. For information on enabling Inbox 
synchronization, see ActiveSync Help on the computer. During synchronization:

• E-mail messages are copied from the Inbox folder of Exchange or Outlook on your 
computer to the Inbox folder on your iPAQ H3000. The e-mail messages on the two 
computers are linked, so when you delete an e-mail message on your iPAQ H3000, it’s 
also deleted from your computer the next time you synchronize.

• E-mail messages in the Outbox folder on your iPAQ H3000 are transferred to 
Exchange or Outlook, then sent from those programs.

NOTE: You can also synchronize e-mail messages with your computer from a remote location. 
For more information, see Chapter 7 (Getting Connected).

Connecting Directly to an E-mail Server
In addition to synchronizing e-mail messages with your computer, you can send and 
receive e-mail messages by connecting to an e-mail server using an optional modem or 
network card connected to your iPAQ H3000. You’ll need to set up a remote connection to 
a network or an ISP, and a connection to your e-mail server. For more information, see 
Chapter 7 (Getting Connected).

When you connect to the e-mail server, new messages are downloaded to the iPAQ H3000 
Inbox folder, messages in the iPAQ H3000 Outbox folder are sent, and messages that have 
been deleted on the e-mail server are removed from the iPAQ H3000 Inbox.

Messages that you receive directly from an e-mail server are linked to your e-mail server 
rather than your computer. When you delete a message on your iPAQ H3000, it’s also 
deleted from the e-mail server the next time you connect.

You can work online or offline. When working online, you read and respond to messages 
while connected to the e-mail server. Messages are sent as soon as you tap Send, which 
saves space on your iPAQ H3000.

When working offline, once you’ve downloaded new message headers or partial mes-
sages, you can disconnect from the e-mail server then decide which messages to download 
completely. The next time you connect, Inbox downloads the complete messages you’ve 
marked for retrieval and sends the messages you’ve composed.
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Using the Message List
Messages you receive are displayed in the message list. By default, the most recently 
received messages are displayed first in the list.

Select the service and folder you want to display.

Select the sort order 
for messages.

Tap to open a 
message.

Tap and hold to 
display a pop-up 
menu of actions.

Tap to connect and to 
send and receive e-mail.Tap to connect to the 

selected service.
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When you receive a message, tap it in the list to open it. Unread messages are displayed in 
bold.

When you connect to your e-mail server or synchronize with your computer, Inbox down-
loads only the first 100 lines of each new message by default. No e-mail attachments are 
downloaded. The original messages remain on the e-mail server or your computer. 

You can mark the messages that you want to retrieve in their entirety the next time you 
synchronize or connect to your e-mail server. In the message list, tap and hold the message 
you want to retrieve. On the pop-up menu, tap Get Full Copy. The icons in the Inbox mes-
sage list give you visual indications of message status.

You’ll need to download a full message before you can view its attachments. Attachments 
appear as icons in a window pane at the bottom of the message. Tapping an attachment 
icon opens the attachment if it has been fully downloaded or marks it for download the 
next time you synchronize or connect to your e-mail server.

You specify your downloading preferences when you set up the service or select your syn-
chronization options. You can change them at any time:

• Change options for Inbox synchronization using ActiveSync options. For more infor-
mation, see ActiveSync Help.

• Change options for direct e-mail server connections in Inbox on your iPAQ H3000. 
Tap Tools then tap Options. On the Service tab, tap the service you want to change.

Tap to return to 
the message list.

Tap to show or hide 
the complete header.

Tap to delete 
this message.

Tap to view the previous 
or next message.

Tap to reply to or for-
ward this message.
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Composing E-mail Messages

To compose an e-mail message:
1. Tap New. 

2. Enter an e-mail address in To, or select a name from the contact list by tapping the 
Address Book button. 
All e-mail addresses entered in the e-mail fields in Contacts appear in the Address 
Book.

3. Compose your message.

4. Tap Send when you’ve finished the message.

The message is placed in the Outbox folder on your iPAQ H3000 and will be delivered in 
one of two ways:

• They are transferred to the Outbox folder in Exchange or Outlook on your computer 
and sent the next time you synchronize.

• They are transferred to your e-mail server the next time you connect. In Inbox, make 
sure the appropriate service is selected on the Services menu. Then tap the Connect 
button (or Connect on the Services menu).

Tap to show or hide the 
complete header.

Tap to send the message.

Tap to attach a file.

Tap to check names in the To, Cc, and Bcc boxes with 
names in Contacts and/or an online address book.

Tap to display the address book.
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Managing E-mail Messages and Folders
By default, messages are displayed in one of four folders for each service you’ve created: 
Inbox, Deleted (local), Outbox, and Sent. The Deleted folder contains messages that have 
been deleted on the iPAQ H3000. If you are using IMAP4, you may see a Deleted Items 
folder. This folder is for messages deleted on the e-mail server. The behavior of the 
Deleted and Sent folders depends on the options you have chosen. In the message list, tap 
Tools then Options. On the Message tab, select your options.

If you want to organize messages into additional folders, tap Tools, then New Folder to 
create new folders. To move or copy a message to another folder, in the message list, tap 
and hold the message then tap Move to or Copy to on the pop-up menu.

Folder behavior with ActiveSync

If you move e-mail messages into a folder you create, the link is broken between these e-
mail messages and their copies on the computer. When you synchronize next, the e-mail 
messages in the folder you created will not be synchronized. In addition, e-mail messages 
that are missing from the iPAQ H3000 Inbox folder will be deleted from the Inbox folder 
on the computer so that both Inbox folders match. This prevents you from getting dupli-
cate copies of an e-mail message, but it also means that you will no longer have access to 
the e-mail messages you move out of Inbox except from the iPAQ H3000.

Folder behavior with a direct connection to an e-mail server

The behavior of the folders you create depends on whether you are using POP3 or IMAP4:

• If you are using POP3, folders will behave like they do when using ActiveSync.
• If you are using IMAP4, the folders you create and the messages you move are mir-

rored on the e-mail server. For example, if you move two messages from the Inbox 
folder to a folder called Family, the e-mail server will create a copy of the Family 
folder and move the messages into that folder. Therefore, messages are available to 
you anytime you connect to your e-mail server, whether it is from your iPAQ H3000, 
laptop computer, or computer. This synchronization of folders occurs when you create 
a new folder, move e-mail messages into a folder, or tap Synchronize Folders on the 
Services menu. If you want to view the messages in a folder while disconnected from 
your e-mail server, select the folder then tap Folder Available Offline on the Services 
menu. This downloads the e-mail message in the folder to your iPAQ H3000.
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chapter 5 

COMPANION PROGRAMS
The companion programs consist of Microsoft Pocket Word, Microsoft Pocket Excel, 
Microsoft Money*, Windows Media Player for Pocket PC, Microsoft Reader, and 
Microsoft Pocket Streets*.

* Available for English operating systems only.

To switch to a companion program on your iPAQ H3000 Pocket PC, tap Programs on the 
 menu, then tap the program name, or press the QStart button, select a category from 

the pop-up menu at the bottom of the screen, then tap the program icon. 

Pocket Word
Pocket Word works with Microsoft Word on your computer to give you easy access to 
copies of your documents. You can create new documents on your iPAQ H3000, or you 
can copy documents from your computer to your iPAQ H3000. Synchronize documents 
between your computer and your iPAQ H3000 so that you have the most up-to-date con-
tent in both locations.

Use Pocket Word to create documents, such as letters, meeting minutes, and trip reports. 
To create a new file, tap , Programs, Pocket Word, then New. A blank document 
appears. Or, if you’ve selected a template for new documents in the Options dialog box, 
that template appears with appropriate text and formatting already provided. You can open 
only one document at a time; when you open a second document, you’ll be asked to save 
the first. You can save a document you create or edit in a variety of formats, including 
Pocket Word (.psw), Rich Text Format (.rtf), and Plain Text (.txt). 
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Pocket Word contains a list of the files stored on your iPAQ H3000. Tap a file in the list to 
open it. To delete, make copies of, and send files, tap and hold a file in the list. Then, 
select the appropriate action on the pop-up menu.

You can enter information in Pocket Word in one of four modes (writing, drawing, typing, 
and recording), which are displayed on the View menu. Each mode has its own toolbar, 
which you can show and hide by tapping the Show/Hide Toolbar button on the command 
bar.

NOTE: You can change the zoom magnification by tapping View then Zoom. Then select the per-
centage you want. Select a higher percentage to enter text and a lower one to see more of 
your document.

NOTE: If you’re opening a Word document created on a computer, select Wrap to Window on 
the View menu so that you can see the entire document.

Select the type of folder you want displayed in the list.

Tap to change the 
sort order of the list.

Tap to open a document.

Tap and hold an item 
to see a pop-up 
menu of actions.

Tap to create a new 
document.
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Typing Mode
Using the input panel, enter typed text into the document. For more information on enter-
ing typed text, see Chapter 2 (Basic Skills).

To format existing text and to edit text, first select the text. You can select text as you do in 
a Word document, using your stylus instead of the mouse to drag through the text you 
want to select. You can search a document to find the text you want by tapping Edit then 
Find/Replace.

Tap and hold to 
see a pop-up 
menu of actions.

Tap to change for-
matting options.

Tap to format text.

Tap to show or hide the toolbar.

Tap to return to the document list (changes are saved automatically).



5-4 Companion Programs

Writing Mode
In writing mode, use your stylus to write directly on the screen. Ruled lines are displayed 
as a guide, and the zoom magnification is greater than in typing mode to allow you to 
write more easily. For more information on writing and selecting writing, see Chapter 2 
(Basic Skills).

NOTE: If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, and 
can be edited and manipulated as described in the following section.

Written words are converted to graphics (metafiles) when a Pocket Word document is 
converted to a Word document on your computer.

With Space button selected, 
drag to insert space. An arrow 
appears showing the space 
direction and size.

Tap to highlight 
selected text.

Pen button
Space button

Tap to select formatting options, such as pen weight and line color.



Companion Programs 5-5

Drawing Mode
In drawing mode, use your stylus to draw on the screen. Gridlines appear as a guide. When 
you lift your stylus off the screen after the first stroke, you’ll see a drawing box indicating 
the boundaries of the drawing. Every subsequent stroke within or touching the drawing 
box becomes part of the drawing. For more information on drawing and selecting draw-
ings, see Chapter 2 (Basic Skills).

Recording Mode
In recording mode, embed a recording into your document. Recordings are saved as .wav 
files. For more information on recording, see “Enter Information on Your iPAQ” in Chap-
ter 2. For more information on using Pocket Word, tap  then Help.

Resize an object by 
dragging the 
selection handles.

Tap to select formatting 
options such as line weight, 
fill color, and line color.

Pen button
Tap an arrow to see your choices.

Select Shape on the pop-up menu to 
convert objects to proper shapes.
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Pocket Excel
Pocket Excel works with Microsoft Excel on your computer to give you easy access to 
copies of your workbooks. You can create new workbooks on your iPAQ H3000, or you 
can copy workbooks from your computer to your iPAQ H3000. Synchronize workbooks 
between your computer and your iPAQ H3000 so that you have the most up-to-date con-
tent in both locations.

Use Pocket Excel to create workbooks, such as expense reports and mileage logs. To cre-
ate a new file, tap , Programs, Pocket Excel, then New. A blank workbook appears. 
Or, to select a template for a new workbook, tap Tools, Options, then tap New. The tem-
plate you selected appears with appropriate text and formatting already provided. You can 
open only one workbook at a time; when you open a second workbook, you’ll be asked to 
save the first. You can save a workbook you create or edit in a variety of formats, includ-
ing Pocket Excel (.pxl) and Excel (.xls).

Pocket Excel contains a list of the files stored on your iPAQ H3000. Tap a file in the list to 
open it. To delete, make copies of, and send files, tap and hold a file in the list. Then select 
the appropriate action from the pop-up menu.

Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, sort-
ing, and filtering. To display the toolbar, tap View then Toolbar. 

NOTE: If your workbook contains sensitive information, you can protect it with a password. To do 
so, open the workbook, tap Edit, then Password. Every time you open the workbook, you 
will need to enter the password, so choose one that is easy for you to remember but hard 
for others to guess.

Cell contents 
appear here as 
you enter them.

Format button

AutoSum button

Zoom button
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Tips for Working in Pocket Excel
Note the following when working in large worksheets in Pocket Excel:

• View in full-screen mode to see as much of your worksheet as possible. Tap View then 
Full Screen. To exit full-screen mode, tap Restore.

• Show and hide window elements. Tap View then tap the elements you want to show or 
hide.

• Freeze panes on a worksheet. First select the cell where you want to freeze panes. Tap 
View then Freeze Panes. You might want to freeze the top and leftmost panes in a 
worksheet to keep row and column labels visible as you scroll through a sheet.

• Split panes to view different areas of a large worksheet. Tap View then Split. Then 
drag the split bar to where you want it. To remove the split, tap View then Remove 
Split.

• Show and hide rows and columns. To hide a hidden row or column, select a cell in the 
row or column you want to hide. Then tap Format, then Row or Column, then Hide. 
To show a hidden row or column, tap Tools, then Go To, then type a reference that is 
in the hidden row or column. Then tap Format, then Row or Column, then Unhide.

For more information on using Pocket Excel, tap  then Help.

Microsoft Money*
* Available for English operating systems only.

Use Microsoft Money to easily enter and view your financial transactions, check your 
account balances, and track your investments. If you are using Microsoft Money on your 
computer, you should synchronize first so that you won’t have to enter your accounts and 
other required information on your iPAQ H3000 by hand. Before you can synchronize, 
you will need to run the Setup program found in the MSMoney folder under Extras on the 
ActiveSync CD. The first time you synchronize, all Microsoft Money information on the 
iPAQ H3000 will be replaced with information from your computer. If you do not use 
Microsoft Money on your computer, Microsoft Money on the iPAQ H3000 can still be 
used to help organize your finances, but you will not be able to synchronize the financial 
information with your computer.
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Getting Started

To create a new account:
1. Tap , Programs, Microsoft Money, then New. A screen for entering account 

details with a Required and an Optional tab appears.

2. Enter the name and type of the account on the Required tab and the other information 
you want to record on the Optional tab then tap OK. 
The name of the account appears in the Account Manager with its opening balance. 
The total of all balances for your accounts appears at the bottom of the screen.

The upper-left corner of the screen shows which view you are in, for example, Account 
Manager. 

To navigate within Microsoft Money:
1. Tap the name Account Manager. A list of the five screens within Microsoft Money 

appears. 

2. Tap the screen you want to see. 

Tap to create a new account.

Balance for all accounts.

Ending balance for 
each account.

Tap to view the Account Register.

Tap and hold to see a pop-up 
menu of actions.

Select the screen you want displayed.
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Using the Account Register
To view the Account Register for an account, tap it in the Account Manager. The Account 
Register displays all transactions for that account that are stored on your iPAQ H3000. For 
each transaction, you will see the date, the payee, the amount, and the running balance of 
your account as a result of the transaction. The ending account balance is displayed at the 
bottom of the screen.

NOTE: Tap the name of the current account in the upper-right corner and select another account 
from the list to switch between accounts.

Select the account 
you want displayed.

Transaction amount

Transaction payee

Tap to view details.
Tap and hold to see a 
pop-up menu of actions.

Running balance for account

Ending balance for account

Tap to create a new transaction.
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Entering Transactions
Once you have the Account Register open, tap New to create a new transaction.

On the Required tab, Microsoft Money automatically creates a withdrawal and enters 
today’s date. If you are not entering a withdrawal, tap the Type box and select Deposit or 
Transfer. You can also change the account in which the transaction is being created. Then, 
tap the Payee box. Using the input panel, enter the payee for your transaction. As you 
type, Microsoft Money tries to guess the payee that you are entering from your list of 
existing payees. If Microsoft Money guesses correctly, tap another field or tap Tab to 
accept the payee. 

When you accept a payee, Microsoft Money enters the same amount, category, and sub-
category that you used for the last transaction with that same payee. This information gets 
entered on the Required tab and the Optional tab. This AutoComplete+ feature helps you 
quickly enter similar transactions, such as ATM withdrawals. If AutoComplete+ has 
entered the wrong information, use the input panel to correct it.

NOTE: If you do not want Microsoft Money to automatically enter information, tap Tools then 
Options and turn off AutoComplete+.

Tap to return to the Account 
Register (the transaction is 
saved automatically).

Tap to select the transaction type.

Tap to select another account.

Tap to enter the payee.

Tap to enter the date.

Tap to enter the amount.

Tap to create a split transaction.
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Entering and Tracking Investments
In the Investments screen, you can track the value of the investments in your portfolio. 
The Investments screen displays each investment with the current number of shares, their 
price, and market value. The total market value for all of your investments is displayed at 
the bottom of the screen.

Tap New to create a new investment. On the new investment screen, enter the name, sym-
bol, current price, and number of shares. Tap OK to save the new investment.

Microsoft Money can update investment prices from the MoneyCentral website. To do 
this, open a connection to the Internet and tap Update Investments on the Tools menu. 
When the update is complete, Microsoft Money will record the date and time and display 
it after Last Quote Update at the bottom of the screen. If you do not have an Internet con-
nection from your iPAQ H3000, you can manually update the investment prices by tap-
ping the investment and entering a new price with the input panel.

NOTE: Microsoft Money can get a quote update over any direct (IP) Internet connection, including 
a wireless connection or network connection. If you cannot get a quote update, check 
with your Internet service provider (ISP) or network administrator to see if you require a 
proxy server to connect to the Internet. If so, tap Tools then Options and set up the proxy 
server.

For more information on using Microsoft Money, tap  then Help.

Market symbol for investment

Number of shares

Tap to view details.

Tap and hold to see a 
pop-up menu of actions.

Latest market price

Market value of investment

Total market value of all investments

Time at which quotes were 
last updated, if available

Tap to create a new investment.

Tap to update investment prices from MoneyCentral website.
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Windows Media Player for Pocket PC
Use Windows Media Player for Pocket PC to listen to digital audio files. To switch to 
Windows Media Player, tap , Windows Media Player.

Using Windows Media Manager for Pocket PC
Use Windows Media Manager for Pocket PC on the computer to create digital audio files 
in Windows Media format and to transfer audio content to your iPAQ H3000 or storage 
card. With Windows Media format, you can create high-quality audio for your iPAQ 
H3000 without using large amounts of iPAQ H3000 memory.

You can transfer the following media formats to your iPAQ H3000 for use with the Win-
dows Media Player: WMA (Windows Media Audio), MP3 (MPEG Audio Layer 3), and 
WAV (waveform).

Active playlist

Indicates the progress 
of the current track

Skip forward

Play/Pause

Repeat playlist

Volume

Track information

Skip back

Shuffle playlist

Stop
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Windows Media Manager is included in the Extras folder on the ActiveSync CD. You 
must install Windows Media Manager on your computer to copy and convert digital audio 
files.

What is Packaged Content?
Packaged content is digital music that has been encrypted for distribution to prevent unau-
thorized access to copyrighted content. Windows Media Player for Pocket PC cannot play 
packaged content without a valid license. First use Windows Media Player on the com-
puter to obtain packaged content that has a license that allows transferring the content to 
your iPAQ H3000. Then use Windows Media Manager for Pocket PC to transfer the pack-
aged content and its license to your iPAQ H3000 or storage card. To successfully transfer 
packaged content, your iPAQ H3000 or storage card may require a hardware serial num-
ber. 

You can play packaged content until the license expires. During license download, you 
will be informed of the terms of the license. License terms can be for an unlimited time, a 
set amount of time, or a set number of playbacks. A license can support content being cop-
ied to a iPAQ H3000 or storage card an unlimited number of times or one time only. Terms 
are entirely dependent on the content provider.
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Using the Playlist Manager
Use the playlist manager to set the track playback order. All My Music is the default play-
list. It contains all digital audio files available for playback on your iPAQ H3000 and stor-
age card. To see a list of recently selected playlists, tap Select Playlist. To create or edit 
playlists, tap All Playlists.

Tap and hold a track or playlist to perform actions such as copying, moving, and deleting. 
For more information on using Windows Media Player, tap  then Help.

Microsoft Reader
Use Microsoft Reader to read or listen (with Audible) to electronic books on your iPAQ 
H3000.

Download books to your computer from your favorite eBook website. Then, use Active-
Sync to copy the book files to your iPAQ H3000. The books appear in the Reader Library, 
where you can tap them in the list to open them. 

Each book consists of a cover page, an optional table of contents, and the pages of the 
book. Page through the book by using the Direction key on your iPAQ H3000 or by tap-
ping the page number on each page. You can annotate the book with highlighting, book-
marks, notes, and drawings. You can also search for text and look up definitions for words.

The Reader Guidebook contains all the information you'll need to use the software. To 
open the Guidebook, tap Guidebook on the Reader command bar. Or, on a book page, tap 
the book title then tap Guidebook on the pop-up menu.

To switch to Microsoft Reader, tap , Programs, then Microsoft Reader.

Default playlist of all tracks

Previously selected playlists

Playlist management
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Getting Books on Your iPAQ H3000
You can download book files from the Web. Just visit your favorite eBook retailer and fol-
low the instructions to download the book files. Sample books and a dictionary are also 
included in the MSReader folder in the Extras folder on the ActiveSync CD. Use Active-
Sync to download the files from your computer to your iPAQ H3000 as described in the 
Read Me file in the MSReader folder. 

Using the Library
The Library is your home page. It displays a list of all books stored on your iPAQ H3000 
or storage card. You can go to the Library by tapping Library on the Reader command 
bar. Or on a book page, tap the book title then tap Library on the pop-up menu.

Tap the title in the Library list to open a book.

Reading a Book
Each book consists of a cover page, an optional table of contents, and the pages of the 
book. Navigation options are listed in the bottom portion of the cover page. The first time 
you open a book, you’ll probably want to go to the first page or to the table of contents, if 
there is one. Subsequently, whenever you open the book, you’ll be automatically taken to 
the last page read.

Tap to select a sort order.

Tap to scroll through 
the Library list.

Tap to specify the 
books you want to 
display in the list.

Tap to open a book.

Tap an icon to navi-
gate to other parts 
of the Reader.



5-16 Companion Programs

In addition to the text, each book page includes a page number and book title.

You can also page through a book by using the Navigation button on your iPAQ H3000.

Using Reader Features
Reading a book electronically gives you several options not available with paper books. 
These options are available from any book page.

Select text by dragging across the text on the page. Then, tap an option on the pop-up 
menu, as described here:

• Search for Text. Find text in a book by tapping Find on the pop-up menu. Change the 
text that appears in the Find box, if necessary, and tap the desired Find option. The 
Reader finds the text and highlights it on the page. Tap outside the Find box to close it. 
To return to your original page, tap the title then tap Return on the pop-up menu.

• Copy Text. You can copy text from a book into any program that accepts text. On a 
book page, select the text you want to copy. Then, tap Copy Text on the pop-up menu. 
The text you’ve copied can be pasted into the program of your choice.

• Bookmarks. When you add a bookmark to a book, a color-coded bookmark icon 
appears in the right margin. You can add multiple bookmarks to a book. Then, from 
anywhere in the book, you can tap the bookmark icon to go to the bookmarked page.

• Highlights. When you highlight text, it appears with a colored background, just as if 
you used a marker pen. 

• Notes. When you attach a note to text, you enter the text in a note pad that appears on 
top of the book page. A note icon appears in the left margin. You can show or hide the 
note by tapping the icon.

Tap to select a navigation button.
Tap to turn the page.

Drag to select text and 
then tap an option.
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• Drawings. When you add a drawing, a drawing icon appears in the bottom-left corner 
of the page, and drawing tools appear across the bottom of the page. Draw by dragging 
your stylus.

NOTE: To see a list of a book’s annotations, including bookmarks, highlights, text notes, and 
drawings, tap Annotations Index on the book’s cover page. You can tap an entry in the 
list to go to the annotated page.

Removing a Book
When you’ve finished reading a book, you may want to delete it to conserve space on your 
iPAQ H3000. If a copy of the book is stored on your computer, you can download it again 
at any time. To remove a book from your iPAQ H3000, tap and hold the title in the Library 
list then tap Delete on the pop-up menu.

Pocket Streets*
* Available for English operating systems only.

The Pocket Streets feature, included in Microsoft Expedia Streets and Trips 2000, 
AutoRoute Express Great Britain 2000, and Microsoft MapPoint 2000, delivers thou-
sands of miles of street map information to your iPAQ H3000. You can create custom 
maps of unfamiliar cities, towns, and villages. 

Installing Pocket Streets
Pocket Streets is included in the Extras folder on the ActiveSync CD. To install Pocket 
Streets on your device, go to the PStreets folder in the Extras folder on the ActiveSync CD 
and follow the instructions in the Read Me file.

Getting Maps on Your iPAQ H3000
Sample maps are included in the PStreets folder in the Extras folder on the ActiveSync 
CD. Use ActiveSync Explore to copy the files from your computer to your iPAQ H3000. 
For more information on copying files using ActiveSync, see ActiveSync Help.
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Creating Map and Pushpin Files for Your iPAQ H3000 
1. Draw a box around the area you want to save as a map in Microsoft Expedia Streets 

and Trips 2000, AutoRoute Express Great Britain 2000, or Microsoft MapPoint 2000. 

2. Click Create Map For Pocket Streets on the Tools menu. 

3. Click Create. 

4. Navigate to the folder where you want to save the map, then type a file name for the 
map.

5. Click Save. When you create a map, all visible Pushpins in the portion of the map that 
you selected are also exported. A map file and a corresponding Pushpin file are created 
for your iPAQ H3000.

6. Copy the maps (.mps) and/or Pushpin files (.psp) that you've created for use with 
Pocket Streets to the My Documents folder on your iPAQ H3000. For more informa-
tion on using ActiveSync to copy files, see ActiveSync Help on the computer.

Viewing Maps
To open a map, tap Tools, Maps, then the name of the map you want to see. If you don't 
see the name, tap Tools, Maps, then Open Map, select the folder where you stored the 
map, then tap the name in the list.

For more information on using Pocket Streets, tap  then Help.

Tap to mark the map 
with a Pushpin.

Tap to move the map view.
Tap to zoom in and out.
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chapter 6

POCKET INTERNET EXPLORER
Use Pocket Internet Explorer to view Web pages in either of these ways:

• During synchronization with your computer, download your favorite links, mobile 
favorites, and mobile channels that are stored in the Mobile Favorites subfolder in 
Internet Explorer on the computer.

• Connect to an Internet service provider (ISP) or network and browse the Web. To do 
this, you’ll need to create the connection first, as described in Chapter 7 (Getting 
Connected).

To switch to Pocket Internet Explorer, tap  then Internet Explorer.

The Mobile Favorites Folder
Only items stored in the Mobile Favorites subfolder in the Favorites folder in Internet 
Explorer on your computer will be synchronized with your iPAQ H3000. This folder was 
created automatically when you installed ActiveSync. 

Favorite Links
During synchronization, the list of favorite links in the Mobile Favorites folder on your 
computer is synchronized with Pocket Internet Explorer on your iPAQ H3000. Both com-
puters are updated with changes made to either list each time you synchronize. Unless you 
mark the favorite link as a mobile favorite, only the link will be downloaded to your iPAQ 
H3000, and you will need to connect to your ISP or network to view the content. For more 
information on synchronization, see ActiveSync Help on the computer.
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Mobile Favorites 
If you are using Microsoft Internet Explorer 5 on your computer, you can download 
mobile favorites. (You can install Microsoft Internet Explorer 5 from the Extras folder on 
the ActiveSync CD.) Synchronizing mobile favorites downloads Web content to your 
iPAQ H3000 so that you can view Web pages while you are disconnected from your ISP 
and computer.

Use the Internet Explorer 5 plug-in installed with ActiveSync to create mobile favorites 
quickly.

To create a mobile favorite:
1. Click Tools then Create Mobile Favorite in Internet Explorer 5 on your computer.

2. Enter a new name in the Name box to change the link name. 

3. Select a desired update schedule in Update.

4. Click OK. Internet Explorer downloads the latest version of the Web page to your 
computer.

NOTE: If you want to download the pages that are linked to the mobile favorite you just cre-
ated, in Internet Explorer on the computer, right-click the mobile favorite then click 
Properties. On the Download tab, specify the number of links deep you want to 
download. To conserve iPAQ H3000 memory, only go one level deep.

5. Synchronize your iPAQ H3000 and computer. Mobile favorites that are stored in the 
Mobile Favorites folder in Internet Explorer 5 are downloaded to your iPAQ H3000.

NOTE: If you did not specify an update schedule in step 3, you will need to manually down-
load content to keep the information updated on your computer and iPAQ H3000. 
Before synchronizing with your iPAQ H3000, in Internet Explorer on your computer, 
click Tools then Synchronize. You will see the most recent content was downloaded 
to the computer, and you can manually download content, if needed.

You can add a button to the Internet Explorer toolbar for creating mobile favorites. In 
Internet Explorer 5 on your computer, click View, Toolbars, then Customize.

To save iPAQ H3000 memory

Mobile favorites take up storage memory on your iPAQ H3000. To minimize the amount 
of memory used:

• In the settings for the Favorites information type in ActiveSync options, turn off pic-
tures and sounds or stop some mobile favorites from being downloaded to the iPAQ 
H3000. For more information, see ActiveSync Help.

• Limit the number of downloaded linked pages. In Internet Explorer on the computer, 
right-click the mobile favorite you want to change then Properties. On the Download 
tab, specify 0 or 1 for the number of linked pages you want to download.
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Channels
Channels are websites designed specifically for offline viewing on your iPAQ H3000. You 
can subscribe to two types of channels at no fee: AvantGo Channels (Available for English 
operating systems only.) and mobile channels.

Using AvantGo Channels*
* Available for English operating systems only.

AvantGo is a free interactive service that gives you access to personalized content and 
thousands of popular websites. Unlike mobile channels, you can subscribe to AvantGo 
channels directly from your iPAQ H3000. Then, you synchronize your iPAQ H3000 and 
computer or connect to the Internet to download the content. For more information, visit 
http://avantgo.com/help.

To sign up for AvantGo: 
1. Add the Mobile Application Link information type to ActiveSync by installing it from 

the AvantGo folder in the Extras folder on the ActiveSync CD.

2. Tap the Favorites button to display your list of favorites in Pocket Internet Explorer 
on your iPAQ H3000.

3. Tap the AvantGo Channels link.

4. Tap the Activate button.

5. Follow the directions on the screen. You will need to synchronize your iPAQ H3000 
with your computer then tap the My Channels button to complete the AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in your list of favorites 
to see a few of the most popular channels. To add or remove channels, tap the Add or 
Remove link.

http://avantgo.com/help
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Using Mobile Channels
Mobile channels are sites you subscribe to on your computer. They are stored in the Chan-
nels subfolder in the Mobile Favorites folder in Internet Explorer 4.0 or later and are 
downloaded to your iPAQ H3000 during synchronization.

To see a list of mobile channels you can subscribe to at no fee, visit the Pocket PC Mobile 
Channel List Web page (www.microsoft.com/pocketpc). Click on the name of the channel 
you want to subscribe to, then click the Add Mobile Channel button and select Make 
available offline to download the channel to your computer. The mobile channel will be 
transferred to your iPAQ H3000 the next time you synchronize. For more information on 
synchronization, see ActiveSync Help on the computer.

Use Pocket Internet Explorer
You can use Pocket Internet Explorer to browse mobile favorites and channels that have 
been downloaded to your iPAQ H3000 without connecting to the Internet. You can also 
connect to the Internet through an ISP or a network connection and browse the Web.

Favorites button
Home button

Refresh button

http://www.microsoft.com/pocketpc
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To view mobile favorites and channels:
1. Tap the Favorites button to display your list of favorites. 

2. Tap the mobile favorite or channel you want to view. 

You’ll see the page that was downloaded the last time you synchronized with your com-
puter. If the page is not on your iPAQ H3000, the favorite will be dimmed. You will need 
to synchronize with your computer again to download the page to your iPAQ H3000 or 
connect to the Internet to view the page.

Tap the favorite you 
want to view.

Tap to add or delete 
a favorite link.
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To browse the Web:
1. Connect to the Internet or your network in either of the following ways:

2. Connect using Connections, as described in Chapter 7 (Getting Connected). Then 
switch to Pocket Internet Explorer by tapping it on the  menu. 

3. Connect in Pocket Internet Explorer. To select a service or type of connection, tap 
Tools then Options. Tap the Connections tab and select the connection type. Then, 
whenever you want to connect to the selected service, tap Tools then Connect. 

NOTE: You can have Pocket Internet Explorer automatically connect to the Internet when you 
attempt to access a page that is not stored on your iPAQ H3000 by specifying a con-
nection in the Connection tab in Options and selecting Access remote content 
automatically.

4. Go to a specific Web page in either of these ways once connected:

• Tap the Favorites button then tap the favorite you want to view.
• Tap View then Address Bar. In the address bar that appears at the top of the 

screen, enter the Web address you want to visit then tap Go. Tap the arrow to 
choose from previously entered addresses.

5. Tap Tools then Disconnect to end the connection.

NOTE: To add a favorite link while using the iPAQ H3000, go to the Web page you want to add, 
tap the Favorites button, tap the Add/Delete tab, tap the Add button, and enter a name 
for the favorite link.



Getting Connected 7-1

chapter 7

GETTING CONNECTED
You can use your iPAQ H3000 to exchange information with other Windows-powered 
devices as well as your computer, a network, or the Internet. Use the Infrared (IR) port on 
your iPAQ H3000 to send and receive files between two devices. In addition to using a 
cradle, cable, or IR port to connect your iPAQ H3000 to your computer, you can connect 
to your computer while away from the office by using a remote connection. You can also 
connect your iPAQ H3000 to a network or the Internet by using a remote connection. You 
have the following connection options:

• Connect to your Internet service provider (ISP). Once connected, you can send and 
receive e-mail messages by using Inbox and view Web pages by using Pocket Internet 
Explorer. If this is the method you want to use, see “Connect to an ISP”. The commu-
nication software for creating an ISP connection is already installed on your iPAQ 
H3000. Your service provider will provide software needed to install other services, 
such as paging and fax services.

NOTE: Your ISP may not support receiving e-mail on a Pocket PC. Contact your ISP for 
details.

• Connect to the network at your company or organization. Once connected, you can 
send and receive e-mail messages by using Inbox, view Web pages by using Pocket 
Internet Explorer, and synchronize with your computer. If this is the method you want 
to use, see “Connect to Your Network”.

• Connect to your computer to synchronize remotely. Once connected, you can synchro-
nize information such as your Pocket Outlook data. If this is the method you want to 
use, see ActiveSync Help on your computer or Connections Help on the iPAQ H3000.
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Transfer Items Using Infrared
Using the IR port on your iPAQ H3000, you can send and receive information, such as 
contacts and appointments, with another Windows-powered device at speeds of up to 
115.2Kbps. 

To send information:
1. Switch to the program where you created the item you want to send and locate the item 

in the list. If you want to send more than one item, drag the stylus across the items you 
want to send.

2. Align the IR ports so that they are unobstructed and within a range of one foot (30 cm).

3. Tap and hold the item, then tap Send via Infrared on the pop-up menu.

NOTE: You can also send items, but not folders, from File Explorer. Tap and hold the item you 
want to send, then tap Send via Infrared on the pop-up menu.

To receive information:
1. Align the IR ports so that they are unobstructed and within a range of 12 inches (30 

cm).

2. Tap , Programs, then Infrared Receive. 

NOTE: You can also receive items from Tasks, Contacts, Calendar, and Notes by tapping Tools, 
then Receive via Infrared in list view.
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Connect to an ISP
You can connect to your ISP by creating a modem connection. Once connected, you can 
send and receive e-mail messages and view Web pages.

To create a modem connection to an ISP:
1. Get the following information from your ISP: ISP dial-up access telephone number, 

user name, password, and TCP/IP settings. Some ISPs require information in front of 
the user name, such as MSN/username.

2. Install a CompactFlash modem card using the optional iPAQ CF Card Expansion Pack 
or a PCMCIA modem card using the optional iPAQ PC Card Expansion Pack. 

NOTE: For information on ordering Compaq iPAQ Expansion Packs, see the Accessories Informa-
tion card included in the shipping box, or visit the Compaq iPAQ H3000 home page at 
www.compaq.com/products/handhelds/.

3. Tap  then Settings. On the Connections tab, tap Modem.

4. Tap New connection.

http://www.compaq.com/products/handhelds
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5. Enter a name for the connection, such as “ISP Connection”.

6. Select your modem type in the Select a modem list. If your modem type does not 
appear, try re-inserting the modem card. 

NOTE: You should not need to change any settings in Advanced. Most ISPs now use a server-
assigned address. If the ISP you are connecting to does not use a server-assigned 
address, tap Advanced then the TCP/IP tab and enter the address. When finished, tap OK 
then Next.

7. Enter the access phone number, and tap Next.

8. Select other desired options, and tap Finish.

9. Specify your current location and phone type (most phone lines are tone) on the Dial-
ing tab. These settings will apply to all connections you create.

Once you have created the connection, it appears in , Programs, Connections. To 
start the connection, remove your iPAQ H3000 from the cradle, tap the connection icon, 
enter your user name and password, and tap Connect. Once connected, you can:

• Send and receive e-mail messages by using Inbox. Before you can use Inbox, you need 
to provide the information it needs to communicate with the e-mail server. For specific 
instructions, see “Connect Directly to an E-mail Server”, later in this chapter.

• Visit Web pages by using Pocket Internet Explorer. For information, see Chapter 6 
(Pocket Internet Explorer).

NOTE: You can quickly return to Modem Settings to change connection settings by tapping the 
Modem link at the bottom of the Connections folder. To return to the Connections folder, 
tap the Connections link.

Connect to Your Network
If you have access to a network, you can send e-mail messages, view intranet pages, syn-
chronize your iPAQ H3000, and possibly access the Internet. You can connect to your net-
work in one of two ways:

• Create a modem connection by using a RAS account. Before you can create this 
modem connection, your network administrator will need to set up a RAS account for 
you. If this is the method you want to use, see “To create a modem connection to a net-
work”.

• Use an Ethernet card and a net tap to connect to the network. If this is the method 
you want to use, see “To create an Ethernet connection to a network”.
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To create a modem connection to a network:
1. Get the following information from your network administrator: dial-up access tele-

phone number, user name, password, domain name, and TCP/IP settings.

2. Install a CompactFlash modem card using the optional iPAQ CF Card Expansion Pack 
or a PCMCIA modem card using the optional iPAQ PC Card Expansion Pack. 

NOTE: For information on ordering Compaq iPAQ Expansion Packs, see the Accessories Informa-
tion card included in the shipping box, or visit the Compaq iPAQ H3000 home page at 
www.compaq.com/products/handhelds/.

3. Tap  then Settings. On the Connections tab, tap Modem.

4. Tap New connection.

5. Enter a name for the connection, such as “Company Connection.”

6. Select your modem type in the Select a modem list. If your modem type does not 
appear, try reinserting the modem card. 

NOTE: You should not need to change any settings in Advanced. Most servers now use a server-
assigned address. If the server you are connecting to does not use a server-assigned 
address, tap Advanced then the TCP/IP tab and enter the address. When finished, tap OK 
then Next.

7. Enter the access phone number, and tap Next.

8. Select other desired options, and tap Finish.

9. Specify your current location and phone type (most phone lines are tone) on the Dial-
ing tab. These settings will apply to all connections you create.

Once you have created the connection, it appears in , Programs, Connections. To 
start the connection, remove your iPAQ H3000 from the cradle, tap the connection icon, 
enter your user name, domain, and password, and tap Connect. Once connected, you can:

• Send and receive e-mail messages by using Inbox. Before you can use Inbox, you 
need to provide the information it needs to communicate with the e-mail server. For 
specific instructions, see “Connect Directly to an E-mail Server”, later in this chapter.

• Visit Internet or intranet Web pages by using Pocket Internet Explorer. You may 
need to set up a proxy server to visit Internet Web pages. For more information on set-
ting up a proxy server, see Pocket Internet Explorer Help on the iPAQ H3000.

• Synchronize. For more information, see ActiveSync Help on the computer.

http://www.compaq.com/products/handhelds
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To create an Ethernet connection to a network:

You do not need to create a new connection on your iPAQ H3000. Instead, you must pur-
chase and configure an Ethernet card that is compatible with your iPAQ H3000. 

1. Get the following information from your network administrator: user name, password, 
and domain name.

2. Install the optional CompactFlash or PCMCIA Ethernet card into your optional CF 
Card or PC Card Expansion Pack. For instructions on inserting and using the Ethernet 
card, see the owner’s manual for the card.

NOTE: For information on ordering Compaq iPAQ Expansion Packs, see the Accessories Informa-
tion card included in the shipping box, or visit the Compaq iPAQ H3000 home page at 
www.compaq.com/products/handhelds/.

Network Settings will appear automatically the first time you insert the card, so that 
you can configure the Ethernet card. Most networks use DHCP, so you should not 
have to change these settings unless your network administrator instructs you to do so.

3. Tap OK. (If it does not appear or to change settings later, tap , then Settings. On 
the Connections tab, tap Network then the adapter you want to change.)

4. Connect the Ethernet card to the network by using a network cable. For information, 
see your owner's manual.

If you want to synchronize your iPAQ H3000, tap , then Programs. Tap the Connec-
tions folder, then ActiveSync. Select Network Connection as the connection method 
then tap Connect. Remote synchronization with a computer will work only if you have set 
up a partnership with that computer through ActiveSync and have set ActiveSync to allow 
remote connections. Other restrictions apply. For more information on synchronizing 
remotely, see ActiveSync Help on the computer.

If you want to access your e-mail server or the intranet, tap , then Settings. On the 
Connections tab, tap Network then the Identification tab. Enter your user information. If 
you need assistance, see your network administrator. 

Once connected, you can do the same activities as listed in the preceding section.

http://www.compaq.com/products/handhelds
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End a Connection 
If you started the connection from a program, such as Inbox or Pocket Internet Explorer, 

disconnect from that program first. Then, tap  then Today. Tap  or  at the bottom 
of the screen then Disconnect. To end a network connection, remove the card from your 
iPAQ H3000.

Connect Directly to an E-mail Server
You can set up a connection to an e-mail server so that you can send and receive e-mail 
messages by using a modem or network connection and Inbox on your iPAQ H3000.

NOTE: The ISP or network must use a POP3 or IMAP4 e-mail server and an SMTP gateway.

Inbox does not currently support connecting with proprietary e-mail protocols such as 
Juno, or Virgin Net. However, you can still access the Internet through these services. 
There may be third-party programs available that would enable you to send and receive 
e-mail messages through proprietary protocols.

You can use multiple e-mail services to receive your messages. For each e-mail service 
you intend to use, first set up and name the e-mail service. If you use the same service to 
connect to different mailboxes, set up and name each mailbox connection.

To set up a e-mail service:
1. Tap Services, then New Service in Inbox on your iPAQ H3000. 

2. Select POP3 or IMAP4 as the service type, name the service, and tap Next. For infor-
mation on which service type to select, ask your ISP or network administrator.
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3. Select a connection from the Connection list. If you have not created a connection, 
select Create new connection and follow the steps in the wizard. When you return to 
this screen at the end of the wizard, select the connection you created from the Con-
nection list.

A wizard will walk you through the remaining steps. For an explanation of a screen, tap 
Start then Help. When finished, tap Services then Connect to connect to your e-mail 
server. For more information on using the Inbox program, see “Inbox: Sending and 
Receiving E-mail Messages” in Chapter 4.

Get Help on Connecting
More information on the procedures described here, as well as information on additional 
procedures, can be found in the following locations:

• “Inbox: Sending and Receiving E-mail Messages” in Chapter 4.

• Online Help on the iPAQ H3000. Tap  then Help. Tap View, All Installed Help, 
then Inbox or Connections.

• ActiveSync Help on the computer. In ActiveSync, click Microsoft ActiveSync Help 
on the Help menu.

• Appendix A, “Tips and Troubleshooting”.
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appendix a

TIPS AND TROUBLESHOOTING
This chapter contains troubleshooting information that can help you to solve any problems 
you might encounter with your iPAQ H3000. It also has a tips section that may help you to 
get better service from your iPAQ H3000. 

If you can't solve a particular problem, see “Where to Find Information” in Chapter 1. The 
various documents and websites listed here may have the information you need to solve 
the problem.

To help diagnose a malfunction, use the Diagnostic utility, which activates a debugging 
and system diagnostic tool. Press the QMenu button, then tap QUtilities, Self Test. For 
more information, see "Self Test" in Chapter 2.

If you encounter a problem that you cannot solve, contact Compaq technical support or 
your service provider for assistance.

Reset the iPAQ H3000 and Clear Memory 

Resetting the iPAQ
If your iPAQ H3000 responds slowly, stops responding as expected, or “freezes,” try reset-
ting it. A reset causes the iPAQ H3000 to restart and re-adjust memory allocation. 
Unsaved data in open windows may be lost. Use the stylus to press and hold the Reset but-
ton for about two seconds.
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NOTE: Do not turn off your iPAQ as it must remain on in order to reset.

Clearing memory
If you want to clear all data from your iPAQ H3000 and return it to the factory settings, 
you should clear the memory. 

1. Using the stylus, slide open the On/Off door on the base of the iPAQ H3000.

2. Slide the On /Off switch to the Off position using the stylus. Wait about one minute, 
then slide the switch to the On position.

Clearing memory deletes all data and restores the iPAQ H3000 to its default set-
tings. Programs installed at the factory remain, while data you have created and 
programs you have installed are erased.
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3. Close the Battery On/Off door using the stylus.

NOTE: Use CF Backup/Restore or ActiveSync to keep a backup of your iPAQ data so that if you 
need to clear memory, you can restore the data on your iPAQ. For more information, see 
“Backup and Restore Data” in Chapter 2, and ActiveSync Help on the computer.

Battery Loses Power
When the battery is low, you will see a battery icon in the status bar of the Today screen. 
Recharge a low battery as soon as possible. If your iPAQ H3000 shuts down, you still have 
about 24 hours to recharge the battery before you lose the data on your Pocket PC. 

You want your iPAQ H3000 battery charge to last as long as possible, especially when 
you’re on the road. Under normal conditions, you can get many hours of use from a full 
charge. The following tips to help you get the most from them:

Use external power whenever possible

Use the AC adapter to plug your iPAQ H3000 into external power whenever possible, 
especially when:

• Establishing a remote connection (some modems use a lot of power).
• Using the backlight feature of your iPAQ H3000 display.
• Connecting to a computer.
• Playing audio files for extended periods.

Shorten auto-suspend time

While on battery power, your iPAQ H3000 automatically suspends operation if you 
haven’t touched the hardware buttons or used the stylus for three minutes. Maximize bat-
tery life by shortening the time. Press the QMenu button, then press Power, and adjust the 
On battery power setting.

Letting the battery fully discharge has the same effect as clearing memory: all data 
is lost and your iPAQ H3000 returns to its factory settings. If your iPAQ H3000 shuts 
down, you should recharge the battery within 24 hours.
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Turn off sounds you don’t need

The iPAQ H3000 produces sounds in response to a number of events, such as warnings, 
appointments, and screen taps or hardware-button presses. To optimize battery life, turn 
off any sounds you don’t need. Tap  then Settings. On the Personal tab, tap Sounds & 
Reminders and clear check boxes on the Volume and Reminders tabs.

Turn off notification light

Tap  then Settings. On the Personal tab, tap Sounds & Reminders. On the Remind-
ers tab, clear the Flash light for check box.

If You Forget Your Password
If you forget your password, you’ll need to clear memory on the iPAQ H3000. See “Reset 
the iPAQ H3000 and Clear Memory”, earlier in this appendix.

If you’ve used ActiveSync or CF Backup/Restore to create a backup file, all of your pro-
gram data can be restored. Your Pocket PC password is removed and you can set a new 
password.

If You Run Out of iPAQ H3000 Memory
Memory on your iPAQ H3000 is shared between storage memory and program memory. 
Storage memory is used to store the information you create and programs you install. Pro-
gram memory is used to run programs on your iPAQ H3000. The iPAQ H3000 automati-
cally manages the allocation between storage and program memory. However, in some 
situations, such as when memory is low, the iPAQ H3000 may not be able to automatically 
adjust the allocation. If you receive a message stating that storage or program memory is 
unavailable, try the following solutions:
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Storage memory

• Move data to a storage card.

• Tap , Programs, then File Explorer. Tap and hold the file you want to move, and 
tap Cut. Browse to the My Documents folder in the storage card folder, tap Edit, then 
tap Paste. Files stored in folders other than My Documents or stored in subfolders 
within subfolders in My Documents may not show up in the list view of some pro-
grams. When using Notes, Pocket Word, or Pocket Excel, you can also move files by 
opening the item and tapping Tools or Edit then Rename/Move.

• Move e-mail attachments. In Inbox, tap Tools then Options. On the Storage tab, 
select Store attachments on storage card. All attachments are moved to the storage 
card, and new attachments are automatically stored on the storage card.

• Set programs such as Notes, Pocket Word, and Pocket Excel to automatically save new 
items on the storage card. In the program, tap Tools then Options.

• If you are copying files from your computer or device to your iPAQ H3000, try adjust-
ing the slider in the Memory setting. Tap  then Settings. On the System tab, tap 
Memory and check whether the slider can be adjusted manually before copying files.

• Delete unnecessary files. Tap , Programs, then File Explorer. Tap and hold the 
file, then tap Delete on the pop-up menu. To find your largest files, tap  then Find. 
In the Type list, tap Larger than 64 KB, then tap Go.

• In Internet Explorer options, delete all files and clear history. In Internet Explorer, tap 
Tools then Options. Tap Delete Files and Clear History.

• Remove programs you no longer use. Tap  then Settings. On the System tab, tap 
Remove Programs. Tap the program you want to remove, then Remove.

• Clear program memory as described in the following section. This will free some pro-
gram memory so that it can be allocated to storage memory.

Do not delete files of which the function is unknown. This can cause programs or 
features to malfunction. It may be appropriate to make a backup before deleting 
files.
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Program memory
• Stop programs you are not currently using. In most cases, programs automatically stop 

to free needed memory. However, in some situations, such as when confirmation dia-
log boxes are waiting for a user response, the program may not be able to automati-
cally stop. To check the state of your active programs, tap  then Settings. On the 
System tab, tap Memory then the Running Programs tab. Tap the program you want 
to view, then tap Activate. Close any open windows or messages and return the pro-
gram to list view. If this doesn’t work, you can stop the program manually. First, make 
sure that your work is saved by closing open items and returning the program to list 
view. Then, stop the program by tapping Stop or Stop All on the Running Programs 
tab. 

• Clear storage memory as described in the preceding section. This will free some stor-
age memory so that it can be allocated to program memory.

• Reset your iPAQ H3000, as described in “Reset the iPAQ H3000 and Clear Memory”, 
earlier in this appendix.

Screen Freezes or Responds Slowly
Reset your iPAQ H3000. See “Reset the iPAQ H3000 and Clear Memory”, earlier in this 
appendix. If the symptom continues, you may have run out of memory. Check your mem-
ory usage and clear storage memory as described above.

Screen is Blank
If the iPAQ H3000 doesn’t respond when you briefly press the Power button, press and 
hold the button for a full second. If that doesn’t work, try the following in order until the 
problem is resolved:

• Plug the iPAQ H3000 into AC power.
• Reset the iPAQ H3000. See “Reset the iPAQ H3000 and Clear Memory”, earlier in this 

appendix.

Screen is Dark
Prolonged exposure to direct sunlight may cause your iPAQ H3000 screen to temporarily 
darken. This is normal for LCD screens and is not permanent.
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Screen is Hard to Read
• Turn on the backlight, by holding down the Power button for one second. 
• Adjust the backlight brightness level. Press the QMenu button, then tap Backlight, 

Super Bright. 
• Position a lamp so that the light shines directly on the screen.
• If you’re having a hard time viewing a document in Notes, try changing the size of the 

view. To do this, tap a zoom percentage on the Tools menu. In Pocket Word and 
Pocket Excel, on the View menu, tap Zoom then select a zoom percentage. In Pocket 
Internet Explorer, on the View menu, tap Text Size then select a size.

• If you’re having a hard time viewing Pocket Outlook data, try enlarging the display 
font. To do this within Calendar, Tasks, or Contacts, tap Tools, then Options, then 
select Use large font.

Inaccurate Response to Stylus Taps
Adjust the touch screen to respond more accurately to screen taps. Tap , then Settings. 
On the System tab, tap Align Screen. 

Slow or No Response
Reset the iPAQ H3000. See “Reset the iPAQ H3000 and Clear Memory”, earlier in this 
appendix.

Infrared (IR) Connection Problems
If you are unable to use IR to transfer information, try the following:

• Transfer only one file or no more than 25 contact cards at a time.
• Line up the IR ports so that they are unobstructed and within a range of 12 inches (30 

centimeters). 
• Make sure nothing is between the two IR ports. 
• Adjust the room lighting. Some types of light interfere with IR connections. Try mov-

ing to a different location or turning off some lights.
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Modem Connection Problems
You may encounter the following problems when using a modem. Additional trouble-
shooting information is available in Connections Help on the iPAQ H3000 and Active-
Sync Help on the computer.

Can’t dial out
• Remove your iPAQ H3000 from the cradle. You cannot connect using a modem if 

your iPAQ H3000 has an active connection with the computer.
• Verify that the iPAQ Expansion Pack is installed properly and that the modem is firmly 

seated and connected to the telephone jack.
• Make sure the telephone line is analog. (Analog telephone lines transmit data in analog 

instead of digital form. Your home telephone line is most likely analog, while office 
telephone lines are often digital.)

• If you create a modem connection for an external modem, select Hayes Compatible 
on COM1 as your modem. If you are using a modem card, select the modem card as 
your modem.

• To use an external modem, you need to use a NULL modem cable and appropriate 
adapters to connect the external modem to your iPAQ H3000.

• Make sure the modem is waiting for a dial tone. Tap  then Settings. On the Con-
nections tab, tap Modem. Tap your connection and tap Next twice. Make sure Wait 
for dial tone before dialing is selected.

• For international calls, allow more time for the call to go through. Tap  then Set-
tings. On the Connections tab, tap Modem. Tap your connection and tap Next twice. 
Clear Cancel the call if not connected within or increase the number of seconds 
allowed. For information on dialing patterns, see Connections Help on the iPAQ 
H3000.

Connecting a modem to a digital telephone line may damage your modem. If 
unsure, ask a knowledgeable person before connecting the modem.
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Can dial out but can’t make a proper connection
• Make sure the network to which you are trying to connect supports the Point-to-Point 

Protocol (PPP). Your Internet service provider or network administrator can verify 
this.

• Verify that the location is correct. Tap  then Settings. On the Connections tab, tap 
Modem. On the Dialing tab, make sure that Location reflects your current location. 
Tap Dialing Patterns to make sure the correct sequence of numbers is being dialed. 
For information on dialing patterns, see Connections Help on the iPAQ H3000.

• Verify that you are using the right phone number for the modem you are trying to 
reach. Tap  then Settings. On the Connections tab, tap Modem. Tap the connec-
tion then Next and double-check the phone number you are trying to reach.

Connection is unreliable
• Make sure the modem is firmly seated and connected to your iPAQ H3000 and the 

telephone jack.

• Disable call waiting. Tap  then Settings. On the Connections tab, tap Modem. On 
the Dialing tab, select Disable call waiting. Then enter the disable code specified by 
your telephone company.
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Network Connection Problems
• The following solutions may help if you encounter problems when using a network 

card for network connections. Additional troubleshooting information is available in 
Connections Help on the iPAQ H3000 and ActiveSync Help on the computer.

• Verify that you have an Ethernet card that is compatible with your iPAQ H3000.

• Verify that you have added necessary server information. Tap  then Settings. On 
the Connections tab, tap Network. Tap your installed adapter (usually your Ethernet 
card's name) and enter any necessary information. Most networks use DHCP, so you 
should not have to change these settings unless your network administrator instructs 
you to do so.

• If Network Connection isn't listed as a connection method in the ActiveSync dialog 
box when starting synchronization, wait a few minutes and try again. Also, if synchro-
nization does not start right away, the network is probably busy, and it may take a 
minute for your iPAQ H3000 to connect to the network.

• Make sure that the proper drivers for your card are installed on the iPAQ H3000. For 
more information, see the owner’s manual for the network card.

• Verify with your network administrator that your user name and password are correct.
• Verify with your network administrator that the network you are trying to connect to is 

available, or try to connect to it from another computer. 
• You may need to change the device name if you are trying to connect to a network and 

cannot because another device with the same name is already connected. To change 
the device name, tap  then Settings. On the System tab, tap About, then the 
Device ID tab.

Cable Connection Problems
The following solutions may help if you encounter problems when connecting to your 
computer. Additional troubleshooting information is available in Connections Help on the 
iPAQ H3000 and ActiveSync Help on the computer.

• Ensure the iPAQ H3000 is turned on.
• If a modem or Ethernet card is inserted into your iPAQ H3000, remove it.

• Ensure that you do not have any other active connections. Tap  then Today. Tap 

 or  at the bottom of the screen, then Disconnect.

• Ensure the cradle’s cable is securely plugged into the appropriate port on the back of 
your computer. Use the cable that came with the iPAQ H3000 cradle without any extra 
cables or extenders attached.

• Ensure your iPAQ H3000 is securely placed into the cradle.
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Routine Maintenance
This section provides recommended guidelines for taking care of your iPAQ H3000. Fol-
lowing these guidelines helps ensure the longevity of your iPAQ and reduces the risk of 
damage. 

Routine Care
To keep your iPAQ H3000 in good condition and working properly, follow these guide-
lines: 

• Keep your iPAQ away from excessive moisture and temperature extremes. Do not 
expose your iPAQ to liquids or precipitation.

• Do not place anything on top of your iPAQ to prevent damage to the screen.
• Store your iPAQ in a protective case when not in use.
• Clean your iPAQ by wiping the screen and the exterior with a soft, damp cloth moist-

ened only with water.

• Avoid exposing your iPAQ to direct sunlight or strong ultraviolet light for extended 
periods of time. Also avoid scratching the surface of the screen and banging it against 
hard objects.

• Only use the iPAQ stylus to prevent scratching the screen.

Battery Guidelines
Because of the type of battery used in your iPAQ H3000, follow local regulations regard-
ing the safe disposal of your iPAQ H3000. Your Compaq vendor can advise you on local 
regulations, and/or the existence of any battery disposal programs in operation. 

The iPAQ H3000 should not be disposed of along with the general household waste. In 
order to forward them to recycling or dispose of them properly, please use the public col-
lection system or return them to Compaq, your authorized Compaq partners, or their 
agents.

To reduce the risk of electric shock or damage to the internal components, do not 
spray liquid directly on the screen or allow excess liquid to drip inside your iPAQ. 
Using soap or other cleaning products on the screen may discolor the finish and 
damage the screen.

In North America, dispose of the iPAQ H3000 by taking advantage of the Compaq 
battery recycling program. You will be provided with a postage-paid battery pack 
mailer preaddressed to a reclamation facility where the metals are recycled.
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Travel Guidelines
For safety and convenience when traveling with your iPAQ H3000, follow these guide-
lines: 

• Back up your data before you leave.
• Take a backup copy of your data with you.
• Disconnect all external equipment from your iPAQ.
• Take the AC adapter and new batteries with you.
• Hand-carry your iPAQ in a protective case. Do not check it with your luggage.
• Be aware of potential effects of airport security devices on your iPAQ H3000.

• Check with the airline if you plan to use your iPAQ on the plane. In-flight use of elec-
tronic devices is at the discretion of the airline.

International Travel
Before traveling internationally with your iPAQ H3000, be sure to: 

• Check local customs regulations.
• If using an external modem or CompactFlash/PCMCIA card modem, be sure to have 

the correct modem and cable for the country you are visiting. Telephone lines differ 
from country to country.

Shipping Guidelines
When shipping your iPAQ H3000, follow these guidelines: 

• Safeguard your data by making a backup copy.
• If shipping the backup copy, be sure that the medium (diskette, tape, or CompactFlash 

card) is not exposed to electrical or magnetic impulses while stored or in transit.
• Turn off your iPAQ and disconnect all external devices.
• Pack your iPAQ and all external devices (such as the cradle, cords, and cables) in their 

original packing boxes or in similar packaging with sufficient packing material to pro-
tect them.

There are three types of airport security devices: X-ray machines, magnetic detec-
tors (the device you walk through), and security magnetic wands. You can send 
your device through airport X-ray machines. However, Compaq recommends that 
you do not send your iPAQ through magnetic detectors or expose it to security 
magnetic wands.
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CHARACTER RECOGNIZER 
Using Character Recognizer, you can write characters directly on your iPAQ H3000 
screen with your stylus, just as you would on a piece of paper. The characters you write 
are translated into typed text. Use Character Recognizer anywhere you want to enter text, 
for example, to write a note or to fill in fields in a dialog box. 

The default writing mode for Character Recognizer is lowercase (Jot-compatible) mode. 
In this mode, you write characters in lowercase. The chart at the end of this appendix con-
tains examples of how to write characters in lowercase mode. You can also choose to write 
in uppercase (Graffiti-compatible) mode. In this mode, you write characters in uppercase. 
If you prefer to write in uppercase mode, tap Uppercase Mode in Options on the input 
method menu. Whether a letter appears in uppercase or lowercase when it is converted to 
typed text depends on where in the input panel you write it, not on the mode you have 
selected.
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The Character Recognizer input panel is divided into three writing areas. Letters written in 
the left area (labeled ABC) creates uppercase letters, and letters written in the middle area 
(labeled abc) creates lowercase letters. Use the right area (labeled 123) for writing num-
bers, symbols, special characters, and punctuation. 

Tap to select an 
input method or 
change options.

Tap to show or hide the input panel.
The letter you write is converted to 
typed text that appears on the screen.
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The following chart is a partial display of the characters you can write while in lowercase 
mode (the dot on each character is the starting point for writing). Remember that even 
though you write a letter in its lowercase form, the case of the text that is displayed 
depends on where you write the letter. For example, if you write a lowercase “a” in the 
ABC area, an uppercase “A” is displayed on the screen.

For more information on using Character Recognizer and for demos of all characters, tap 
 on the Character Recognizer input panel.
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REGULATORY NOTICES 

Regulatory Agency Identification Numbers
For regulatory identification purposes your product is assigned an Agency Series number. 
The Agency Series number for this product is Series PE2030*. This series number should 
not be confused with the marketing name (Compaq iPAQ H3000 Pocket PC).

The following accessories have been evaluated for use with your iPAQ H3000 Pocket PC. 
These Compaq-approved accessories can be identified by their assigned series numbers 
listed below. To ensure continued reliable and safe operation of your iPAQ H3000, use 
only the accessories listed below with your iPAQ H3000.

* Intended for use with Listed Class 2, rated 5 Vdc, minimum 2A power supply unit. 

Accessories Agency Series Number

USB Cradle PE2035*

Serial Cradle PE2035*

CF Card Expansion Pack PE2036B

PCMCIA Card Expansion Pack PE2036C*

Bluetooth Expansion Pack PE2036D
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Federal Communications Commission Notice
This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reason-
able protection against harmful interference in a residential installation. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communica-
tions. However, there is no guarantee that interference will not occur in a particular instal-
lation. If this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is encouraged to 
try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected.
• Consult the dealer or an experienced radio or television technician for help.

Modifications
The FCC requires the user to be notified that any changes or modifications made to this 
device that are not expressly approved by Compaq Computer Corporation may void the 
Reference authority to operate the equipment.

Cables
Connections to this device must be made with shielded cables with metallic RFI/EMI con-
nector hoods in order to maintain compliance with FCC Rules and Regulations. Declara-
tion of Conformity for products marked with the FCC logo - United States only. This 
device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired opera-
tion.

For questions regarding your product, contact:

Compaq Computer Corporation
P. O. Box 692000, Mail Stop 530113
Houston, Texas 77269-2000
Or, call 1-800-652-6672 (1-800-OK COMPAQ)

For questions regarding this FCC declaration, contact:

Compaq Computer Corporation
P. O. Box 692000, Mail Stop 510101
Houston, Texas 77269-2000
Or, call (281) 514-3333

To identify this product, refer to the Part, Series, or Model number found on the product.
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Canadian Notice
This Class B digital apparatus meets all requirements of the Canadian Interference-Caus-
ing Equipment Regulations.

Avis Canadien
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le 
matériel brouilleur du Canada.

European Union Notice
Products with CE marking comply with both the EMC Directive (89/336/EEC) and the 
Low Voltage Directive (73/23/EEC) issued by the Commission of the European Commu-
nity. 

Compliance with these directives implies conformity to the following European Norms (in 
brackets are the equivalent international standards): 

• EN55022 (CISPR 22) - Electromagnetic Interference 
• EN50082-1 (IEC801-2, IEC801-3, IEC801-4) - Electromagnetic Immunity
• EN 60950 (IEC60950) - Product Safety

Battery Warning

Airline Travel Notice
Use of electronic equipment aboard commercial aircraft is at the discretion of the airline.

This computer contains an internal lithium polymer battery pack. To reduce the risk 
of fire or burns, do not disassemble, crush, puncture, short external contacts, or 
dispose of in fire or water. Replacement should only be done by a Compaq autho-
rized service provider using the Compaq spare part for this computer.

!
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Power Cords
If you were not provided with a power cord for your iPAQ 3000 Pocket PC or for an AC 
power accessory intended for use with your device, you should purchase a power cord that 
is approved for use in your country.

The power cord must be rated for the product and for the voltage and current marked on 
the product’s electrical ratings label. The voltage and current rating of the cord should be 
greater than the voltage and current rating marked on the product. In addition, the diame-
ter of the wire must be a minimum of 0.75 mm2/18AWG, and the length of the cord must 
be between 5 feet (1.5 m) and 6.5 feet (2 m). If you have questions about the type of power 
cord to use, contact your Compaq authorized service provider.

A power cord should be routed so that it is not likely to be walked on or pinched by items 
placed upon it or against it. Particular attention should be paid to the plug, electrical outlet, 
and the point where the cord exits from the product.

To reduce the risk of personal injury, electric shock, fire, or damage to the equip-
ment:
• Do not disable the power cord grounding plug. The grounding plug is an impor-

tant safety feature.
• Plug the equipment into a grounded (earthed) electrical outlet that is easily 

accessible at all times.
• Disconnect power from the equipment by unplugging the power cord from the 

electrical outlet.
• Do not place anything on power cords or cables. Arrange them so that no one 

may accidentally step on or trip over them.
• Do not pull on a cord or cable. When unplugging from the electrical outlet, 

grasp the cord by the plug.

!
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HARDWARE SPECIFICATIONS

System Specifications

Feature iPAQ H3600 Series iPAQ H3100 Series

Processor StrongARM SA-1110 StrongARM SA-1110 

Memory 32-MB SDRAM or greater 16-MB SDRAM

Display Color TFT, 240 x 320 pixels, 
4K-color support, .24-dot pitch 

Monochrome, 240 x 320 pix-
els, 15-color gray scale, .24-
dot pitch

Backlight 5-level brightness, light sensor 
for automatic adjustment of 
brightness level

Manual adjustment of bright-
ness level

Audio Speaker, 3.5 mm stereo head-
phone jack

Speaker, 3.5 mm stereo head-
phone jack

Infrared IrDA, data transfer up to 115.2 
kb per second

IrDA, data transfer up to 115.2 
kb per second

Communications Communication port, Expan-
sion Pack connector

Communication port, Expan-
sion Pack connector

Indicators 3 mode alarm notification: 
flashing green LED, tone, pop-
up message. Charge light: 
flashing/solid amber LED

3 mode alarm notification: 
flashing green LED, tone, pop-
up message. Charge light: 
flashing/solid amber LED

Battery Lithium Polymer Lithium Polymer
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Physical Specifications

Operating Environment 

iPAQ H3600 
Pocket PC

iPAQ H3600 with 
Basic Style Pack

iPAQ H3100 
Pocket PC

US Metric US Metric US Metric

Height 5.1 in 130 mm 5.2 in 131.6 mm 5.1 in 130 mm

Width 3.3 in 83.5 mm 3.4 in 86.6 mm 3.3 83.5 mm

Depth .63 in 15.9 mm .70 in 17.8 mm .63 in 15.9 mm

Weight 5.8 oz 163.5 g TBD TBD 5.8 oz 163.5 g

US Metric

Temperature Operating 32° to 104°F 0° to 40°C

Nonoperating -4° to 140°F -20° to 60°C

Relative humidity 
(non-condensing) 

Operating 20 to 90% 20 to 90%

Nonoperating 20 to 90% 20 to 90%

Maximum altitude
(un-pressurized)

Operating 15,000 ft. 4,572 m

Nonoperating 40,000 ft. 12,192 m
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